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Acquiring Spatial Data 
 
FWS 
FWS GIS Data Sets: http://www.fws.gov/gis/data/national/index.html 
FWS-GIS List Serve - to subscribe email:  fws-gis@lists.fws.gov 
 
USGS 
The National Map:  http://nationalmap.gov/ 
Earth Resources Observations and Science Center (EROS): http://eros.usgs.gov/  
GAP Analysis:  http://gapanalysis.nbii.gov/portal/server.pt 
Maps, Imagery and Publications: http://www.usgs.gov/pubprod 
Geospatial Data Clearinghouse:  http://www.fgdc.gov/dataandservices  
USGS Earth Explorer:  http://edcsns17.cr.usgs.gov/EarthExplorer/    
National Map Seamless Server:   http://seamless.usgs.gov/ 
National Biological Information Infrastructure (NBII):  http://www.nbii.gov  
National Land Cover Data:  http://www.mrlc.gov/index.php 
 
USDA NRCS 
Soils, aerials & more:  http://datagateway.nrcs.usda.gov/  
  
BLM 
PLSS by state: http://www.geocommunicator.gov/GeoComm/lsis_home/home/index.htm 
 
Census Bureau 
TIGER data:  http://www.census.gov/geo/www/tiger/index.html   
  
EPA 
Surf your Watershed:  http://cfpub.epa.gov/surf/locate/index.cfm 
BASINS:  http://www.epa.gov/OST/BASINS/  
GeoGateway: https://geogateway.epa.gov/geoportal/catalog/main/home.page 
 
NPS 
National Park Service’s GIS Homepage:  http://www.nps.gov/gis  
Integrated Resource Management Application: https://irma.nps.gov/  
 
Other Data Sites 
The Federal Geospatial Platform: http://www.geoplatform.gov/home/  (NEW!) 
Data.gov: http://www.data.gov/  
Microsoft’s Terraserver: http://www.terraserver.com/ 
GIS Data Depot:  http://www.gisdatadepot.com 
State GIS Data:  http://libraries.mit.edu/gis/data/datalinks/statedataweb.html 
 
LIDAR 
USGS LIDAR: http://lidar.cr.usgs.gov/  
NOAA Coastal LIDAR Data:  www.csc.noaa.gov/ldart 







GIS Project Design I: Data Development and Management                                                                  2011 
U.S. Fish and Wildlife Service                              National Conservation Training Center 


 


Acquiring Spatial Data                                                                                      2 


Online Mapping Applications 
FWS Lands Mapper (boundaries and parcels): http://gis.fws.doi.net/fwslands_mapper/  
Critical Habitat Mapper: http://criticalhabitat.fws.gov/  
ArcGIS Explorer: http://explorer.arcgis.com/  
 
ESRI ArcGIS Sites 
ArcGIS Data: http://www.esri.com/data/find-data.html  
ArcGIS Resources:  http://resources.arcgis.com/  
ArcGIS Scripts and Models:  http://resources.arcgis.com/gallery/file/geoprocessing  
 
 
USFWS GIS Contacts by Region 
 


Region Contact Phone Email 


National Chris Lett (303) 274-3574 Chris_Lett@fws.gov 


R1 Mark Kildow (503) 231-2371 Mark_Kildow@fws.gov 


R1 (field rep) David Hines (360) 604-2500 David_Hines@fws.gov 


R2 Ric Riester (505) 248-6851 Ric_Riester@fws.gov 


R3 Mary Balogh (612) 713-5490 Mary_Balogh@fws.gov 


R4 Jason Duke (931) 528-6481 x216 Jason_Duke@fws.gov 


R5 BJ Richardson (413) 253-8335 BJ_Richardson@fws.gov 


R6 Mark Ely (303) 236-4368 Mark_Ely@fws.gov 


R7 Steve Kovach (907) 524-3251 Steve_Kovach@fws.gov 


R8 Pat Lineback (916) 414-6559 Pat_Lineback@fws.gov 


R8 (field rep) Tony McKinney (760) 431-9440 x259 Tony_McKinney@fws.gov 
R9 Endangered 


Species 
Linda Purviance (703) 358-2079 Linda_Purviance@fws.gov 


R9 Federal Aid CJ Huang (303) 275-2344 CJ_Huang@fws.gov 


R9 Fire 
Management 


Bill Leenhouts (208) 387-5584 Bill_Leenhouts@fws.gov 


R9 Migratory 
Bird Mgmt 


Kathy Fleming (301) 497-5902 Kathy_Fleming@fws.gov 


R9 NCTC Mark Richardson (304) 876-7470 Mark_Richardson@fws.gov 


R9 Fisheries & 
Habitat 


Conservation 
Tom Dahl (608) 783-8425 Tom_Dahl@fws.gov 


 
 







201108 Hurricane Irene Data Sources 
Geospatial Information and Remotely Sensed Imagery Products 


September 7, 2011 


Hazards Data Distribution System (HDDS) 


http://hdds.usgs.gov/hdds2/  
 Select Event: “201108_Hurricane_Irene”  click on “+ “and then “Search” 
 
HDDS Rest Services: http://hdds.usgs.gov/ArcGIS/rest/services 


- under 201108_Hurricane_Irene 
- WMS layer Aerial NOAA imagery available ( 08/28/11 )  
 


Emergency Operations Portal GIS Resources 
http://edclxs5.cr.usgs.gov/EO/gis.php 


 
HDDS 


Storm surge depth grids from SLOSH model forecasts 
http://hdds.usgs.gov/hdds2/pub/data/disaster/201108_Hurricane_Irene/data/Map_Products/FEMA 


 
NOAA  
http://edcftp.cr.usgs.gov/pub/data/disaster/201108_Hurricane_Irene/data/AERIAL_NOAA/ 
 


 
 







NY FEMA Aerial Acquired: August 30, 2011  
 http://edcftp.cr.usgs.gov/pub/data/disaster/201108_Hurricane_Irene/data/AERIAL_FEMA_NYS/ 


 
 
 ASTER  


http://edcftp.cr.usgs.gov/pub/data/disaster/201108_Hurricane_Irene/data/TERRA_ASTER_NASA/ 


   







 
Landsat 
http://edcftp.cr.usgs.gov/pub/data/disaster/201108_Hurricane_Irene/data/LANDSAT_TM_USGS/ 
 


 
 
Landsat ETM+ Acquired: August 30, 2011 
http://edcftp.cr.usgs.gov/pub/data/disaster/201108_Hurricane_Irene/data/LANDSAT_ETM+_USGS/ 


 
 
EO Acquired: August 30, 2011 
http://edcftp.cr.usgs.gov/pub/data/disaster/201108_Hurricane_Irene/data/EO_USGS/ 







 
 


USACE Event Lidar  


 
Pre-Event USACE Lidar  


 
 
USGS Pre-Event NED  
http://edcftp.cr.usgs.gov/pub/data/disaster/201108_Hurricane_Irene/data/AERIAL_USACE_LIDAR/ 
 







 
Virginia Pre-Event from HDDS 


BL_VA_2002_virginia_va_2ft/                      
BL_VA_200512_coastal_va_0x5000m/                
BL_VA_200906_virginia_naip_va_1m/   
 


Pre-Event NAIP Imagery from HDDS 
BL_CT_201008_connecticut_naip_ct_1m/                
BL_DC_201004_washington_dc_16cm/                    
BL_DE_200906_delaware_naip_de_1m/                   
BL_MA_201007_massachusetts_naip_ma_1m/              
BL_MD_200906_maryland_naip_md_1m/               
BL_NC_201006_north_carolina_naip_nc_1m/ 
BL_NJ_201007_new_jersey_naip_nj_1m/              
BL_NY_200905_new_york_naip_ny_1m/                   
BL_PA_201005_pennsylvania_naip_pa_1m/               
BL_RI_201007_rhode_island_naip_ri_1m/              


 
HDDS Restricted 


For Access Contact:  Rynn Lamb lamb@usgs.gov or Brenda Jones bkjones@usgs.gov 
 
RADARSSAT and TerraSARX derived Flood polygons 
http://edcftp.cr.usgs.gov/disaster_restricted/201108_Hurricane_Irene/data/Map_Products/ 
 
FEMA surge sensors and RSWG meeting notes 
http://hdds.usgs.gov/hdds2/disaster_restricted/201108_Hurricane_Irene/docs_misc/ 
 
GEOEYE Acquired: August 29, 2011 
http://edcftp.cr.usgs.gov/disaster_restricted/201108_Hurricane_Irene/data/GEOEYE_NGA/ 
 







 


 
 
IKONOS Acquired: August 31, 2011 
http://edcftp.cr.usgs.gov/disaster_restricted/201108_Hurricane_Irene/data/IKONOS_NGA/ 







 


 
NC NCDOT Acquired: August 28, 2011 
http://edcftp.cr.usgs.gov/disaster_restricted/201108_Hurricane_Irene/data/AERIAL_NCDOT/ 
 


 
SPOT  







http://edcftp.cr.usgs.gov/disaster_restricted/201108_Hurricane_Irene/data/SPOT_DOD/ 
 


 


 
RapidEye Acquired: August 31, 2011 
http://edcftp.cr.usgs.gov/disaster_restricted/201108_Hurricane_Irene/data/RAPIDEYE_DOD/ 


 







 
COSMO ISA Acquired: August 29, 2011 
http://edcftp.cr.usgs.gov/disaster_restricted/201108_Hurricane_Irene/data/COSMO_ISA/ 


 
 


WorldView  


 







  
Pre-Event WorldView: 
http://edcftp.cr.usgs.gov/disaster_restricted/201108_Hurricane_Irene/data/WORLDVIEW_NGA/ 
 
Civil Air Patrol  
http://edcftp.cr.usgs.gov/disaster_restricted/201108_Hurricane_Irene/data/AERIAL/NON_INGESTED/ 


 
END HDDS 


License for SPOT Data Buy imagery in EathExplorer 


These data are subject to terms and conditions as specified by the data provider.  Restrictions include 
but are not limited to: 


       - Use of the data is restricted to federal, state, and local civil government agencies and their cooperators  
          with tribal government agencies included for contract year 2 (12/28/2010 to 12/15/2011). 
        - Use of the data in published work shall be attributed to the original data provider. 
        - Any redistributed data shall include copies of the specific license/use agreement originally provided  
          with the data. 
        - For each dataset, a specific license/use agreement is provided with the data describing the terms and 
          conditions. 


Spot-5 Data Buy 
http://edcsns17.cr.usgs.gov/NewEarthExplorer/ 
You must register to see the SPOT-5 imagery.  
 







 
 
Spot-4 Data Buy  
http://edcsns17.cr.usgs.gov/NewEarthExplorer/ 
You must register to see the SPOT-4 imagery.  


 
 







EO1_ALI 


 
 
EO1_HYPERION Acquired: August 30, 2011 


 
 


End EarthExplorer 
 


Pictometry Pre and Post Irene Aerial Oblique Photography  
Pictometry Online (POL) is offering free access for all Federal agencies to Pre and FEMA initiated 
Post Irene aerial photography.   


For Username and Password, contact: 
NANCY BRELOS 
Director, Federal Sales Civilian Agencies 
Pictometry International, Inc. 
Northern Virginia Office 
(703) 581-9059 
nancy.brelos@pictometry.com 


 
FEMA  


    RSS and Data 
    http://www.fema.gov/help/rss.shtm 
 
    FEMA_GIS 







FEMA_GIS public group has been established on www.arcgis.com and several public web services 
have been registered on the site: 


 DRC’s 
 Declared Counties 
 Regions/Offices 
 Hurricane Evacuation Routes 


Planned: 
 Historic Designations 


 


NASA 
MODIS Rapid Response: 


Select Terra or Aqua 721 @ 250meters  For further exploitation use “Download JPG image 
with ancillary files (.zip)” 
http://lance-modis.eosdis.nasa.gov/imagery/subsets/?project=fas&subset=USA4 
 


\ 
http://lance-modis.eosdis.nasa.gov/imagery/subsets/?project=fas&subset=USA8 


 
 
MODIS flood mapping at NASA Goddard Space Flight Center:  


http://oas.gsfc.nasa.gov/floodmap/globalMap.htm  This is the home page where you can 
navigate the map to specific regions.  The MODIS flood mapping algorithm requires cloud 
free pixels to make a flood assessment.  So it will have to wait until the hurricane moves out 
of the area. 
 
Regional links  with .png and shapefiles 
Mid-Atlantic:   
http://oas.gsfc.nasa.gov/floodmap/getTile.php?location=080W040N 
New York / New England:  
http://oas.gsfc.nasa.gov/floodmap/getTile.php?location=080W050N 
 







Two very preliminary MODIS‐based maps of the Irene flooding for the northeastern US are 
online at 
http://floodobservatory.colorado.edu/RapidResponse/2011UnionvilleNYRR.html 
and 
http://floodobservatory.colorado.edu/RapidResponse/2011CTValleyRR.html 


 
NASA TRMM rainfall products 


http://trmm.gsfc.nasa.gov/ 


NGA	 
 Volumes 1 - 7 of the New York/New Jersey Area Urban Search and Rescue 1k Atlas are now 
available on the eFTP.  ( http://www.floodmaps.net/eftp/download.php ) File names:  
 


717266845_NY_NJ_1k_USAR_Atlas_Vol_1.pdf 
768655395_NY_NJ_1k_USAR_Atlas_Vol_2.pdf 
864675903_NY_NJ_1k_USAR_Atlas_Vol_3.pdf 
774285888_NY_NJ_1k_USAR_Atlas_Vol_4.pdf 
827624511_NY_NJ_1k_USAR_Atlas_Vol_5.pdf 
323489379_NY_NJ_1k_USAR_Atlas_Vol_6.pdf 
242080688_NY_NJ_1k_USAR_Atlas_Vol_7.pdf 
 
Files are also available on SMTS: 
NY_NJ 1k USAR Atlas Vol 1.pdf 
NY_NJ 1k USAR Atlas Vol 2.pdf 
NY_NJ 1k USAR Atlas Vol 3.pdf 
NY_NJ 1k USAR Atlas Vol 4.pdf 
NY_NJ 1k USAR Atlas Vol 5.pdf 
NY_NJ 1k USAR Atlas Vol 6.pdf 
NY_NJ 1k USAR Atlas Vol 7.pdf 


USGS 


USGS: Coastal Change Hazards: Hurricanes and Extreme Storms 
http://coastal.er.usgs.gov/hurricanes/irene/coastal-change/updated-assessment.php 
 
USGS Storm surge Sensor Deployment WEB viewer   
http://water.usgs.gov/osw/floods/2011_HIrene/index.html  
Click on the map and you will go directly to the viewer.   


 
International Charter for Disasters  


International Charter was activated yesterday, and the following collections being offered 
through the Intl Charter (to specified end users only.   Project Manager (Sandi Cone, 
charterirene2011@gmail.com ). 
 
Potential International Charter collects:  
RSAT1 - Aug 28  
RSAT2 - Aug 28, 29  
ESA Envisat -  27 and 30 Aug (Chesapeake Bay, NC, SC)  







 


                        
DLR TerraSAR-X, DMCii, KARI and DMI 


 
Naval Research Lab 


http://www.nrlmry.navy.mil/TC.html   
SSMI, TMI, AMSRE, WINDSAT, AMSUB, GAC, GEO, MODIS, OLS 
 
Tropical Cyclone Web Page 
http://www.nrlmry.navy.mil/tc_pages/tc_home.html 
 
GOES Tropics 
http://www.nrlmry.navy.mil/tropics-bin/tropics.cgi 
 


NOAA  
Digital Coast: (lidar data) http://csc-s-maps-q.csc.noaa.gov/dataviewer/viewer.html 
Measured Surge: http://tidesandcurrents.noaa.gov/quicklook/data/IRENE.html 
Irene:  http://www.noaawatch.gov/2011/tc_at09.php 
National Hurricane Center: http://www.nhc.noaa.gov/ 
NHC GIS Data and Products http://www.nhc.noaa.gov/gis/  
Weather: http://weather.gov 
Latest Storm Surge Predictive Files http://www.weather.gov/mdl/psurge/download.php 
Storm Surge Probabilities http://www.nhc.noaa.gov/psurgegraphics_at4.shtml?gm 
Google Map Viewer: http://www.nhc.noaa.gov/psurgegraphics_at1.shtml?gm  
 
Wind Field for North Carolina  







The first part of the Irene data can be found in the following link; 
ftp://ftp.aoml.noaa.gov/hrd/pub/annane/irene/NC 
ftp://ftp.aoml.noaa.gov/hrd/pub/annane/irene/new_NC 
ftp://ftp.aoml.noaa.gov/hrd/pub/annane/irene/new_NY 
ftp://ftp.aoml.noaa.gov/hrd/pub/annane/irene/new_census_data 


 
Hurricane IRENE Response Imagery Viewer:    


Single tiles and zip files:  http://ngs.woc.noaa.gov/storms/irene/ 


 
TMS tiles. http://ngs.woc.noaa.gov/storms/irene/mobile 


Hurricanes @ USA.gov Links to state information 
 http://www.usa.gov/Topics/Weather/Hurricane.shtml 
 
Google.org 2011 Hurricane Season 


http://crisislanding.appspot.com/ 
 
CrisisCommons 
 http://wiki.crisiscommons.org/wiki/Hurricane_Irene 


http://wiki.crisiscommons.org/wiki/Hurricane_Irene_Data_Profile 
 
Geolocated Flood Damage & Coordination Information for VT 


http://vtirene.crowdmap.com/ 
 
ESRI 


ESRI Public Information Disaster Map  
http://www.esri.com/services/disaster-response/hurricanes/latest-news-map.html 
 
ArcGIS Hurricane Irene Viewer 
http://www.arcgis.com/home/webmap/viewer.html?webmap=4a9b65e79ea045ffbd1b6087674ee78b 
 







Hurricane Irene Disaster Response 
http://www.arcgis.com/home/group.html?owner=disaster_response&title=Hurricane%20Irene%20Disaster%20Res
ponse 
 
 
GIS Support Resources (Live weather feeds, data, etc.)  
 http://www.esri.com/services/disaster-response/hurricanes/resources.html 
 
 
 


 
 
USDA Pre-Event Imagery 


USDA NAIP WMS: By State 
NAIP ArcGIS Map Service by State : http://gis.apfo.usda.gov/ArcGIS/services 
Pre-Event 1-meter NAIP Imagery from 2011 available for: SC 
Pre-Event 1-meter NAIP Imagery from 2010 available for: CF, NJ, RI, VA 
Pre-Event 1-meter NAIP Imagery from 2009 available for: DE, MD, NY 
USDA NAIP Imagery on Geospatial Data Gateway: By County 
http://datagateway.nrcs.usda.gov/ 
 
USDA/FSA has requested that the NAIP vendors expidite delivery for imagery 
impacted by Irene. (see map for imagery acquired but not received)   


 
General GIS Data:  


USGS Seamless Data Distribution System  
National Elevation Data Set, 1-meter DOQs and Other National Data 
http://seamless.usgs.gov/ 


 
Data Sources & Web Mapping Applications   
http://sierrafire.cr.usgs.gov/fire_gis_webpage.htm 
 







OGC compliant WMS Servers   
http://www.skylab-mobilesystems.com/en/wms_serverlist.html 


 
State GIS Sites: 


Connecticut http://mapserver.lib.uconn.edu/data/index.htme  
Maine http://www.maine.gov/megis/ 
Maryland http://dnrweb.dnr.state.md.us/gis/data/data.asp 
  MEMA OSPREY http://www.mema.state.md.us/MEMA/MAP.html  
Massachusetts http://www.mass.gov/mgis/ 
New Hampshire http://www.granit.unh.edu/ 
New Jersey https://njgin.state.nj.us/NJ_NJGINExplorer/index.jsp 
New York http://www.nysgis.state.ny.us/  http://www.nysgis.state.ny.us/index.cfm 
North Carolina http://www.nconemap.net/ 


2010 Orthoimagery Rest Services: 
http://imagery.nconemap.com/ArcGIS/rest/services/2010_Orthoimagery/ImageServer 
NC OneMap Post-Hurricane Irene Imagery Viewer  
http://data.nconemap.com/geoportal/hurricane_irene/index.html 


Rhode Island http://www.edc.uri.edu/rigis/ 
Vermont www.vcgi.org   This site is down due to flooding. 


http://www.uvm.edu/~joneildu/downloads/VCGI/ 
The two zip files in this directory contain data from the Vermont Center for Geographic Information.  The data 
are posted here to fill the gap while VCGI recovers from flooding stemming from Hurricane Irene.   


Virginia http://www.virginiaplaces.org/boundaries/gisdata.html 
 


Virginia ArcGIS Service:  
Most Recent Imagery  (2009/2007/2006) web service available without authentication. We are 
also in the process of building a web service for the 2011 imagery we have for the NGA1 
(Virginia Beach – Hampton Urban Area), which will be available in the same location. 
The ArcGIS Server URL is http://gismaps.virginia.gov/arcgis2/services 
The web services you would want are in the MostRecentImagery folder.  
 
 
Vermont 


Vermont CAP Photography 
http://www.uvm.edu/~joneildu/irene/Imagery/30Aug11/CAP_StillImages_30Aug11.zip 
 
Vermont Transportation Status 
ftp://vtransmap.aot.state.vt.us/Maps/VTrans_data_Irene/Damage_Status_Maps/ 
 
Vermont Road Closures  
http://511.vermont.gov/main.jsf 
 







 
Vermont Google Crisis Response additional source of VT road closures, bridge closures, 
Power Outage (KML)  
 http://crisislanding.appspot.com/?crisis=2011_flooding_vermont  
 
Vermont: University of Vermont Flood data 
The data were derived from 20m imagery acquired on August 29, 2011.  In no way should 
this be considered to be a definitive flood map, but I hope it is useful.   We hoped to do 
more flood extent mapping 


      http://www.uvm.edu/~joneildu/irene/Flooding/Flooding_CT_River_VT_SE_29Aug11.zip 
 
    Vermont:  Irene Crowdmap 
       http://vtirene.crowdmap.com/ 
 


Energy / Power Outage 
The National Power Grid 
http://www.nationalgridus.com/ 
Power outage maps for all 50 states 
http://vielmetti.typepad.com/vacuum/2011/06/power-outage-maps.html 
info4disaters.org: an encyclopedia & community forum 
http://info4disasters.org/hurricane-eoc/irene/  


Other Resources: 
Delta State Atlases  (geopdf mapbooks)  
http://mississippi.deltastate.edu/data/USNG_Atlases/ 
http://greatriver.deltastate.edu/IreneUSNG/index.html - Flex viewer 
 


U.S. Government Information Sharing Sites (Restricted Access):  
 
HSIN http://www.hsin.gov  
 







Emergency Management: Hurricane Irene   
https://government.hsin.gov/sites/EmergencyManagement/SysSupport.aspx 
Federal Operations:  Hurricane Irene 
https://government.hsin.gov/sites/FedOperations/DocMgmt.aspx 
 
IRSCC 
https://government.hsin.gov/sites/EmergencyManagement/IRSCC/default.aspx 
IRSCC GeoSpace    
https://government.hsin.gov/sites/EmergencyManagement/IRSCC/SitAware.aspx 


To request access to the IRSCC Portal, please contact the IRSCC Executive Secretariat 
at irscc-execsec@hq.dhs.gov 


 
Intelink-U 
     Damage, Debris, and Flooding Shapefiles 
 Maps: Power and Cellular Outages 
   https://www.intelink.gov/wiki/Hurricane_Irene_2011 


  
Maps  Under DMIGS; IRSCC reports           


      https://www.intelink.gov/inteldocs/browse.php?fFolderId=263031 
 
 NGA Source Americas/Hurricane-Tropical Storm Situational Report (Imagery Tasking)  


https://www.intelink.gov/wiki/NGA_Source_Americas/Hurricane-Tropical_Storm_Situational_Report 
 
Civil Air Patrol 
 https://missions.cap.af.mil/wmirs 
 
Planned Acquisitions: 
NOAA 
NOAA has completed the acquisition RGB imagery.  NOAA will NOT be able to provide Topo 
LIDAR of the same area due to a sensor issue.  
 
  







Products and Resources from Federal/State/Local/Private:  
8/25/2011 
 FEMA 
  


IMAT White Team Geospatial Unit 
Location: VA EOC (Richmond) 
POC: Eric Soucie (eric.soucie@dhs.gov) 
  
Region X Support to Region III 
Location: MEMA (Reisterstown, MD) 
POC: John Edwards (john.edwards2@dhs.gov) 
  


HIFLD Working Group 
  


HSIP Gold/Freedom (Presidentially Declared Disaster) 
www.hifldwg.org 
POC: Jason Barnett (Barnett_jason@bah.com) 


  
DHS 


Critical Infrastructure/Key Resources (CIKR) Maps 
  
Joe Ricks (joe.ricks@dhs.gov) (Richmond PSA) 
Mark Milicich (mark.milicich@dhs.gov) (Norfolk PSA) 
Matt Wombacher (matthew.wombacher@hq.dhs.gov) (National Capital Region PSA) 
Sean Mcaraw ( sean.mcaraw@dhs.gov) (National Capital Region PSA) 
Ray Hanna (raymond.a.hanna@hq.dhs.gov) (Maryland PSA) 
Ken Greeson (ken.greeson@hq.dhs.gov) (Delaware PSA) 
  
Folks here is a resource list as compiled from our RISG GIS Pre Event Call. We will try to 
update this list after each call. Big thanks to Jason Barnett for compiling this list from his 
notes. 


Virginia 
  


Virginia Dept. of Emergency Management (VDEM): 
POC: eocgis@vdem.virginia.gov 
  Storm Surge Road Maps (CAT 1-4) by county 


Currently Identifying Hazards data: Wind, Rain, Storm Surge then will assess risk. 
  
County of Fairfax 
POC: Mike Liddle (Michael.Liddle@fairfaxcounty.gov) 


Dam Inundation Maps  
 


County of Henrico 
POC: Juston Manville (man86@co.henrico.va.us) 


 Web Mapping Application (Web Services available?) 
  







Maryland 
POC: Mick Brierly (mbrierley@mema.state.md.us) 
MEMA OSPREY http://www.mema.state.md.us/MEMA/MAP.html 
  
Pushing hurricane specific data to our publicly facing OSPREY application on MEMA website. 
 
City of Laurel 
Laurel Flex Application 


POC: Sandi Cone (scone@laurel.md.us) 
  
 


Send comments, additions, and corrections to: 
Glenn Bethel, USDA Remote Sensing Advisor 


glenn.bethel@usda.gov  (202)720-1280 
http://edcftp.cr.usgs.gov/pub/data/disaster/201108_Hurricane_Irene/docs_misc/Data_Sources/ 


 





		Spatial_Data_Sites

		Hurricane_Irene_DataSources2011
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Appendix 1 – Managing Imagery  
 


 


Session Objectives:  At the conclusion of this session, you will be able to: 


 


 Evaluate different ways to manage raster datasets within a geodatabase. 
 


 Create a mosaic dataset to reference imagery. 
 


 Modify tabular data in a mosaic dataset. 
 


 Color balance a mosaic dataset 
 


 Create a mosaic dataset to process and view elevation data using functions. 
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Material Created By:  Eric Kelchlin (Oct 2011) 


Revision:  


Software:  ArcGIS 10, SP3 


Data: D:\CSP7200\Appendix\Rasters 


GDB: ImageryGDB (students create) 


MXD: Appendix1.mxd  
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SECTION 1 – Raster Data Models 


There are four ways to manage raster data in a geodatabase for ArcGIS 10: 


Raster Data as an Attribute 


Raster data can be stored directly inside an attribute table as long as you have a raster 
data type assigned to a field.  This method is great for storing small pictures.  Photo-
points on a refuge would be a good application.  The limitation is that you can only have 
1 picture per cell. 


Raster Dataset 


A raster dataset is one image (typically a mosaicked image) stored in a geodatabase.  
The benefit of a raster dataset is that you can seamlessly merge many images into one 
complete mosaicked file, which provides a simple way to manage and view imagery.  
The drawback is that a raster dataset significantly “bloats” the geodatabase because the 
data are stored as uncompressed imagery.  


Raster Catalog  


A raster catalog is a collection of raster data sets (images) that are NOT mosaicked 
together, however they are viewed as one complete image collection.  This method is 
known as a dynamic mosaicking.  Multiple data forms, data types and coordinate 
systems can be displayed together in the same raster catalog.  There are two types of 
raster catalogs: Managed and Unmanaged.   


A managed raster catalog is similar to a raster dataset because the imagery are stored 
directly in the geodatabase.  This simplifies data management, but it can also slow 
down loading speeds if too much imagery is added to the catalog.   


The unmanaged raster catalog links the imagery from the geodatabase to their folder 
location on your PC/server.  The imagery maintains its original file format.    The 
imagery loads faster than in a managed raster catalog.  However, this method requires 
more file management because you can’t simply give someone your geodatabase 
without copying the imagery from the source location. 


Mosaic Dataset (New!) 


A collection of raster datasets (images) stored as a catalog and viewed as a mosaicked 
image, either on your pc or pushed up to an imaging service.  It’s a hybrid of an 
unmanaged raster catalog and a raster dataset.  Mosaic datasets utilize mosaicking 
functions to deliver dynamically processed raster data to the user.  This allows multiple 
products to be created from a single raster source, while maintaining the original raster 
format.   


For more information about mosaic datasets: 
http://www.esri.com/news/arcuser/0610/mosaicdataset.html  
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SECTION 1 – Creating a Mosaic Dataset 


In this section you will create a mosaic dataset for the Marsh Run-Potomac River 
Watershed and modify the way it’s displayed in ArcMap. 


All data are located in the D:\CSP7200\Appendix\Raster folder. 


1. Launch ArcMap and open the Appendix1 map document. 
 


2. Open ArcCatalog and dock on the side of the map view. 
 


3. Create a new file geodatabase in the Raster folder using ArcCatalog. Name it 
ImageryGDB. 
 


 
 


4. Right-click on the geodatabase and select New > Mosaic Dataset.  Name the 
dataset Potomac and give it the appropriate coordinate system as shown below.  
Leave the pixel properties blank.  Click OK when done. 
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5. You now have an empty mosaic dataset showing in your Table of Contents.  The 
next step is to add the rasters into the dataset  


 
Right-click on the Potomac mosaic dataset and select Add Rasters. Change the 


Input to Workspace and browse  to the Watershed folder.  Click the Add 
button to add it into the Source field. 


 


 
 


6. In the Advanced Options, check the boxes next to Build Pyramids and 
Calculate Statistics.  Click OK when done. 
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7. Right-click on the Image layer in the Table of Contents and select Zoom to 
Layer.  You should see the footprint of the images but not the actual imagery.  
Explore the imagery using the zoom tools, notice that the images only appear at 
a specific scale.  This scale can be modified through the properties menu of each 
layer in the mosaic dataset. 
 


 
 


8. It would be useful to see the name of each image as labels in the footprints.  To 
do this, right-click on the Footprint layer and select Label Features.   
 


9. To modify the way the labels are displayed, simply right-click on the Footprint 
layer and select Properties and the Label Tab.   Change the font to 10, click the 
Bold button.  Click Apply.  You can see the font change on the map, so you can 
keep adjusting the text symbology until you find one you like. 
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10. To set the scale at which the labels are viewed, click on the Scale Range button 
and change the values as shown below.  Click OK twice.  Zoom in and out and 
see how the labels change. 
 


 
 


11. Right-click on the Footprint layer again and open the Attribute Table.  You can 
add attributes to the mosaic dataset just like a feature class.  Let’s ID the imagery 
type and when they were taken. 


 
Scroll over to the ProductName field, right-click on the field header and select 
Field Calculator.  Type in “IR Color Ortho Photo” in parentheses and click OK. 
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12. Next, click on the Table Options button  and select Add Field.   Name the 
new field  Imagery_Date, and change the data Type to Date. 
 


 
 


13. Populate the field with Aug 15 2003 using the Field Calculator.  The syntax will 
be #08-15-2003#  


 


 
 


14. Next, let’s correct the color balance of the images.  Close the attribute table. 
Open ArcToolbox and browse to Data Management Tools > Raster > Mosaic 
Dataset and select the Color Balance Mosaic Dataset tool. 
 
Change the fields to what is shown below.  Click OK to run the tool.  Notice how 
the color balance in the keedysville_sw and harpers_ferry images were 
adjusted according to the target raster. 
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15. Next, let’s construct a definition query on the Potomac mosaic dataset to only 
show the Shepherdstown images.  This is a great way to utilize one mosaic 
dataset for many different audiences/needs without reconstructing a whole new 
dataset. 
 
To do this, simply right-click on the Potomac dataset layer and select Properties.   


Select the Definition Tab and click  .   Build the query that 
only shows the Shepherdstown images as shown below.  Click OK twice. 
 


 
 


16. Save  your map document and close ArcMap.  
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SECTION 2 – Creating a Reference Mosaic Dataset to Process Elevation Data 


In this section you will create a series of reference mosaic datasets to create many 
different products from a single Digital Elevation Model raster layer.  This section 
illustrates the power of functions which modify data on the fly for viewing purposes, 
rather than modifying the original data source. 


1. Open ArcCatalog. 
 


2. Right-click on the ImageGDB geodatabase and select New > Mosaic Dataset.  
Name the dataset NCTC_DEM.   
 


Click on the properties button  and import  the coordinate system 
from the idw05 file in the DEM folder.   Leave the pixel properties blank.  Click 
OK when done. 
 


 
 


3. Right-click on the NCTC_DEM mosaic dataset and select Add Rasters.  


Browse  to the DEM folder and add the idw05 file.  Proceed to the next 
step…. 


 
4. Check the Update Overviews box.  Click OK to run the tool. 
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5. Next we’re going to make a reference mosaic dataset to process the DEM into 


a hillshade view.  To do this, open the ArcToolbox window  and select 
Create Referenced Mosaic Dataset in the Data Management Tools > Raster 
> Mosaic Raster toolset. 
 


 
 


6. Populate the fields as shown below.  For the Output, browse to the 
ImageryGDB and name the file Hillshade.  Click OK when done. 
 


 
 


7. Right-click on the Hillshade dataset and select Properties > Functions Tab.  
Right-click on the Mosaic Function and Insert the Hillshade Function.  See 
the example below. 
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8. Change the Z Factor to 2, keeping the rest of the defaults.  NCTC does not 
have a great relief, so this will give it a bit more of a bang for the money.  Click 
OK. 
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9. Right-click on the Mosaic Function, select Properties and change the Output 
Pixel Type to 32 Bit Float.  Click OK twice.  
 
This will greatly enhance the display of the image.  Notice that the detail 
changes as you zoom in and out of the Hillshade layer, this is the result of 
Overlays. 
 


 
 


10. Next, let’s create a shaded relief, which is essentially a colorized version of the 
hillshade.  To do this, create another referenced mosaic dataset using 
ArcToobox as we did above, name it Shaded_Relief.  Make sure to reference 
the NCTC_DEM as above as well.   


 


 
 


11. Right-click on the new Shaded_Relief dataset and insert the shaded relief 
function.  Use a Z Factor of 2.  Click OK. 
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12. Change the Output Pixel Type to 32 Bit Float in the properties of the Mosaic 
Function like we did with the Hillshade layer. 
 


13. Create a new reference mosaic dataset using the steps above and insert the 
Aspect Function.   


 
Modify the Mosaic Function to 32 Bit Float as above. 


 
14. Right-click on the Aspect Function and Insert a Colormap Function to add 


color to your Aspect layer.  
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15. Use the Elevation colormap.  Click OK twice. 
 


 
 


16. Explore your new Aspect layer. 
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Thematic Data Structure Examples for your Refuge GIS or Geodatabase 


 


Example 1 Example 2 


Aerial Photography Annual Performance Plan Database 


Buildings/Structures Buildings 


Cultural Resources Cultural Resources 


Fences and Gates Fences and Gates 


Geology Fire Management Units 


Historic Maps Hunting Zones 


Hydrography Hydrography 


Invasive Species Improved Assets 


LiDAR, Contours and Elevation Managed Wetlands 


Monitoring Sites Management Units 


Oil, Gas and Mining Oil and Gas/Mining 


Othophotography Permanent  Monitoring Sites 


Refuge Management Zones/Units Public Access 


Roads, Railroads and Trails Roads, Trails and Parking 


Signs Signs 


Soils Vegetation/Landcover 


Species Observations Water Management Infrastructure 


Springs and Wells  


Survey Monuments/Data  


Utilities  


Vegetation, Land Cover and Habitat  


Water Structures  


Wildfire and Prescribed Burning  
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File Geodatabase Data Types, Descriptions and Examples 


Data Type Size 
(Bytes) Length Decimal 


Places Description Example 


Short Integer 2 1-4 0 Use for sub-types 10 
Long Integer 4 5-10 0   10000 


Single Floating 4 1-6 0-6   100000.999999 
Double Floating 8 7+ 0+   100000.99999999 


Text   1-255   Default size is 50 Text 
Date     0   12/13/2010 


GUID 16 36 0 Global Unique Identifier; Use as 
the origin key for relationships 


{3F2504E0-4F89-11D3-
9A0C-0305E82C3301} 


BLOB 36-36,965     Binary Large Object, a long 
sequence of binary numbers  Images, multi-media 


Raster       Raster imagery .sid, .tiff, .jpg 


SHAPE Geometry       The geometric datatype used by 
ArcGIS; Cannot delete 


 point, line, polygon, 
multipoint, & multipatch 


Object ID       ESRI auto-generated number; 
Cannot delete 1 


 


Field Precision - identifies the number of digits that can be stored in the field.  


Field Scale – identifies the number of decimal places for floating and double fields 
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Exercise 1 – Establishing Spatial Reference  
 


 
 
Session Objectives:  At the conclusion of this session, you will be able to: 
 
 


 


 Assign a coordinate system to an ArcMap data frame 
 


 Define and transform datum’s and coordinate systems for vector and raster 
datasets 
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Material Created By:  Todd Sutherland (December 2005) 


Revision: Eric Kelchlin (September 2011) 


Software:  ArcGIS 10 SP2 


Directory Path: D:\CSP7200\Exercise1 


Shapefiles: mn_wpas_albers, mn_cnties_utm.shp, p8_brdsrvy.shp, p8_landcov.shp 


Imagery: p08_doq.sid 
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SECTION 1 – Assign a Coordinate System to a Data Frame 
 


Unless stated otherwise, all data are located in D:\CSP7200\Exercise1. 
  


1. Launch ArcMap  and open a New Blank Map. 
 


 
 
 


2. Right-click on the Layers data frame and select Properties.  Click on the 
Coordinate System tab.  By default, no coordinate system is assigned to the 
data frame.  Click OK to close the dialog. 
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3. Add   the wpa_albers.shp layer.  This layer has a projection file (.prj) and 
therefore the data frame will assume the projection. 
 


4. Check the data from properties again.  What coordinate system is the data frame 
now_____________________________? 
 
When adding multiple layers at the same time, ArcMap uses the last layer you 
select to set the data frame’s coordinate system. 
 


5. Add  the counties_utm.shp layer.  You should get a warning “Unknown 
Spatial Reference”.  This layer does not have an associated .prj file. 


 


 
 


This warning does not always appear when adding layers that lack spatial 
reference information.  Hence, it is very important that you always define the 
spatial reference of your layers.  This is vital for shapefiles! 
 


6. Click Full Extent  on the Tools toolbar.  These 2 layers do not overly even 
though both represent features in Minnesota.  The counties_utm layer does not 
have a projection file, therefore Arcmap cannot determine its coordinate system.  
If this layer had this valuable information, then ArcMap could perform an “on-the-
fly projection”.  These two layers would then be aligned in the same coordinate 
space. 
 


7. The native projection for this layer is UTM-Zone 15, NAD83.  So, let’s assign this 
coordinate system to the data frame to get these two layers to line-up. 
 


8. Right-click on the Layers data frame and select Properties.  Select the 
Coordinate Systems tab. 
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9. In the Select a coordinate system section, navigate through the Predefined > 
Projected Coordinate Systems > UTM > NAD 1983 folders and select NAD83 
UTM Zone 15N.  Click OK. 
  


 
 


 
 


10. Click Full Extent  on the Tools toolbar.  Drag the wpa_albers layer on top of 
the counties_utm layer in the Table of Contents. 
 


11. The two layers now overly correctly because the wpa_albers file, which has an 
associated projection file, is projected on the fly from Albers to UTM by ArcMap. 
 


12. Is this the best approach for dealing with this issue?  Why or why 


not______________________________________________________________


_______________________________________________________________? 


 


13. Close  ArcMap.   Do not save changes. 
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SECTION 2 – Using the Define Projection Tool 
 
In this section you will define a projection for the counties_utm.shp file.  For 
shapefiles, defining a projection means that you will be creating a .prj file. 
 


1. Launch ArcCatalog  from the desktop.   
 


2. Right-click on the counties_utm layer in your catalog tree and select 
Properties.  Click on the XY Coordinate System tab and notice how the 
coordinate system is unknown.  Select OK to close the dialog. 
 


 


3. Open ArcToolbox   if it’s not already docked on the right side of your screen. 
 


4. Find the Data Management Tools > Projections and Transformations toolbox 
and double-click on the Define Projection tool. 
 


 
 


5. Navigate to the counties_utm layer and select the properties  icon.  Click 


on the  button and browse to through the Projected Coordinate 
System folders and select the appropriate coordinate system as shown 
below.  Click OK when done.   
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6. Right-click on the counties_utm layer in the catalog tree to see that the 


Coordinate System was assigned correctly. 
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SECTION 3 – Using the Project Tool to Change the Spatial Reference 
 
ArcMap’s on-the-fly projection should only be used for display purposes.  The 
recommended approach is to ensure that all GIS layers have the same spatial reference 
to avoid errors in spatial analyses.  In this section you will change the projection of the 
wpa_albers.shp layer to match the counties_utm.shp layer. 
 


1. In ArcToolbox, navigate to the Data Management Tools > Projections and 
Transformations > Feature toolbox and double-click on the Project tool. 
 


 
 


2. Fill-in the fields as shown below.  Name the layer wpa_utm and save in the 
same folder.  Click OK when done. 
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SECTION 4 – Surviving a Datum Shift 
 
This section demonstrates how one can obtain inaccurate results when conducting 
spatial analyses using layers that are NOT referencing the same spatial reference 
system.  This could easily happen if you have not assigned spatial reference information 
to your files.   
 


1. Close  ArcCatalog and launch ArcMap . 
 


2. Open a New Blank Map and Add  the bird_survey.shp and landcover.shp 
layers.  Click OK at the Unknown Spatial Reference warning dialog if it appears. 
 


3. Notice that both layers appear to align, but if you open the Properties > Source 
tab in the bird_survey layer you’ll see that this layers coordinate system is 
undefined.   
 


4. What’s the coordinate system for the landcover layer_____________________? 
 
A novice user may believe that these layers are using the same coordinate 
system since they both overlay.  They both do in fact use the same map 
projection (UTM Zone 15), but different datums.  Therefore, these 2 layers are 
not using the same spatial reference system. 
 
In Minnesota, the difference between NAD27 and NAD83 coordinates is 
approximately 15 meters for the X value and -213 meters for the Y value.  This 
amount of positional error will cause inaccurate results when performing spatial 
analyses.  To demonstrate this fact, we are simply going to pretend everything is 
OK and conduct our spatial analysis. 
 


5. For our analysis we want to identify all the habitat types that contained greater 
than 5 American Redstart observations in Pool 8 during the 1996 survey. 
 
From the Selection menu, choose Select By Attributes and create a query for 
greater than 5 American Redstarts (code = NAMRE) in the bird_survey layer. 
 


 
 


6. Click Apply and close the Select By Attributes dialog. 
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7. Click on the Selection menu again, but this time choose Select By Location.  
We want to select features from the landcover layer that intersect with the 
selected features of the bird_survey layer. See the example below. 
 


 
 


8. Click Apply and close the Select By Location dialog. 
 


9. Click on the List by Selection icon in the table of contents.   
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10. Right-click on the landcover layer and Open the Attribute table.  Right-click on 
the LCU field and choose Summarize.   
 


11. Just make sure the output is going to your Exercise1 folder.  Click OK. 
 


 
 


12. Click on the List by Source icon.  Right-click on the results table select Open. 
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13. Right-click on the Count_LCU field and select Sort Descending.  What are the 
top three land cover types and what is the count for each? 
 
___________________ ____ 
 
___________________ ____ 
 
___________________ ____ 
 


14. Clear the selected features by clicking on the Clear Selection tool. 
 


 
 
 


Next we are going to perform the same summary as above, but this time transform the 
bird_survey layer to the same datum as the landcover layer.  Before we can do this 
however, we need to examine the metadata and write down the datum and coordinate 
system. 


 
15. Right-click on the bird_survey layer in the table of contents and select Data > 


View Item Description.  To view the datum and coordinate system simply scroll 
down and select the ArcGIS Metadata > Reference System section.  What is 
the answer? 
 
________________________. 
 


16. Next, use the Project tool in ArcToolbox to define the appropriate projection to 
the bird_survey layer.  A quick way to find the tool is simply use the Search tool 


 located on the Standard toolbar or docked at the right side of the screen.   
 
 


17. Select Tools, search for “Project”.  Click the Project (Data Management) item 
on the list to activate the tool. 
 
 


 
 


  







GIS Project Design I: Data Development and Management                                                                   2011 
U.S. Fish and Wildlife Service                              National Conservation Training Center 


 


Establishing Spatial Reference                                                                                                                  13 
 


18. Populate the fields as shown below.  Name the output file bird_survey_NAD83 
and save in the Exercise1 folder.  Since the input and output coordinate systems 
use two different datums, we must select a Geographic Transformation. Click OK 
when done. 
 


 
 
 


19. Your new layer will be added at the top of your table of contents.  If you receive 
an error, refresh the active view and try again. 
 
 


20. Remove the old bird_survey layer and perform the analysis again using the 
bird_survey_NAD83 layer.  What are your answers this time? 


 
___________________ ____ 
 
___________________ ____ 
 
___________________ ____ 


 







GIS Project Design I: Data Development and Management                                                                   2011 
U.S. Fish and Wildlife Service                              National Conservation Training Center 


 


Establishing Spatial Reference                                                                                                                  14 
 


TIP: Unlike shapefiles, geodatabases require you to assign a spatial reference to all 
your layers (known as feature classes in a geodatabase) because a geodatabase has 
integrity and rules that must be followed.  Shapefiles are angry stepchildren with bad 
habits and short memories.  So, choose the right data type for your next GIS project. 
 
 
SECTION 5 – Transforming and Projecting Raster Datasets 
 


1. Clear all selected features and add  the Mn_Imagery.sid raster layer. 
 


2. Notice the Geographic Coordinate Systems Warning dialog appears.  You are 
informed that the layer you just added uses a different geographic coordinate 
system (datum) than the exiting map data or data frame.  It also suggest that you 
may need to choose a different geographic transformation.  It is very important to 
understand what is going on here.  ArcMap warns you of this issue because 
there are several datum transformation methods that could be used and ArcMap 
has automatically selected one for you. 
 


3. Click the  button and verify that the fields match those shown 
below.  Click Close when done. 
 
The image has been on-the-fly projected; the spatial reference information is not 
permanently changed.  This is really just for background use only, not analyses. 
 


 
 
 


4. To permanently change the spatial reference information, first remove the 
Mn_Image layer from the table of contents.  
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5. Use the Search tool  to find the Project Raster tool in ArcToolbox.  Click on 
Project Raster (Data Management) item to activate the tool. 
 


6. Make sure the fields match those as shown below.  Rename the image 
Mn_Image83 and save it in the Exercise1 folder.  Note:  the raster file name 
cannot be longer than 11 characters. 
 


 
 


 
7. Click OK.  The process will take a couple minutes to complete.  Once done, the 


image will automatically appear in your table of contents. 
 


8. Verify that the projection is correct by looking at the metadata as we did 
previously, or by simply right-clicking on the image layer and viewing the Source 
information. 
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9. Close ArcMap.  Do not save your document. 
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Exercise 2 - Geodatabase Design for Legacy Data and Project 
Specific Data Collection  


 


Session Objectives:  At the conclusion of this session, you will be able to: 


 


 Create a file geodatabase with a thematic structure. 
 


 Convert a mess of shapefiles and miscellaneous datasets into a clean and smart 
file geodatabase. 
 


 Create a project specific geodatabase using a structured framework. 
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SECTION 1 – Managing Legacy Data with a File Geodatabase 


This section demonstrates how to use tools in ArcCatalog to convert a mess of 
shapefiles and other datasets into a clean and smart geodatabase.  The first step is to 
examine your data layers and group similar items (i.e. shapefile layers) into file folders.  
These folders can become your feature datasets and thereby structure your 
geodatabase.  The structure can be thematic (i.e. theme based), geographical, project 
specific or a combination of all three.  You can have one geodatabase or many; this will 
depend on how much data you have and also on your project objectives and office 
organizational requirements. 


When you create the feature datasets you will also have to decide on a datum and 
projection.  You can assign different spatial references for the feature datasets within 
the same geodatabase, but this is best done for geographically based designs.  
Thematic designs will typically have the same datum and projection for the data layers 
in the geodatabase. 


Once you have a geodatabase with a structure of empty feature datasets, the next step 
is to create feature classes from your legacy data.  This is your opportunity to delete 
duplicate layers and messy data without metadata.  The data clean-up and compilation 
efforts can be done as part of the data import/loading process while creating new 
feature classes. 


 


TASK 1 – Create a File Geodatabase with a Thematic Structure 


1. Open ArcCatalog. 
 


2. Right-click on the Connect to folder button and select Connect to Folder.  
Navigate to the location of the D:\CSP7200\NCTC folder and click OK.   All of 
your datasets for this exercise will reside in these subfolders. 
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3. Create a new file geodatabase in the GDB folder by simply Right-clicking on the 
GDB folder, choose New and select File Geodatabase. 
 


 
 


4. Name the geodatabase “NCTC” and hit enter on your keyboard.  A new file 
geodatabase has been created.   
 


5. Next, create a new feature dataset that will store our feature classes.  Right-click 
the NCTC geodatabase and select New > Feature Dataset. 
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6. Type Boundary for the name of this feature dataset.  Click Next . 
 


7. We need to assign a coordinate system for the feature dataset.  Select 
Projected Coordinate System > UTM > NAD 1983 > UTM Zone 18N for the 
coordinate system.  This is the standard projection used at NCTC.  Click Next. 
 


 
 
 


8. Click Next in the vertical coordinate system dialog, you won’t need to define this 
in most situations. 
 


9. In the next dialog, keep the default tolerances and click Finish. Notice how the 
feature dataset is added below the NCTC geodatabase. 
 


10. Create another feature dataset, however, since we are using the same 
coordinate system for all feature datasets, simply right-click on the Boundary 
feature dataset and select Copy. 
 


11. Next, right-click on the NCTC geodatabase and select Paste.  Click OK at the 
data transfer dialog.   
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12. Rename the feature class by simply right-clicking on the Boundary_1 feature 
class and selecting Rename.  Rename it to Hydrology.  This technique can be 
quite the time saver. 
 


 
 
 


13. Create two more feature datasets using the same methodology.  Name the first 
“Transportation” and the other “Monitoring”.  


 


14. Can you think of any other feature datasets that would help organize your GIS 
data at your office? 
 


_____________________________ 


_____________________________ 


_____________________________ 


_____________________________ 


_____________________________ 
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TASK 2 – Creating a New Feature Class from an Old Shapefile 


1. Right-click on the Boundary feature dataset, choose Import and select Feature 
Class (single…). 
 


 
 


2. For Input Features, click the browse folder  button and navigate to the 


Shapefiles folder.  Choose the Boundary.shp file and click the Add 
button. 
 


3. Type ”ntc_boundary “ in the Output Feature Class field.  Click OK. 
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4. Expand the Boundary feature dataset and select the new feature class.  Click on 
the Preview tab to view the new feature class you just imported. 
 


5. Change the Preview field from Geography to Table.  What two land status 
attributes are listed in the table?  ________ and _________. 
 


 
 
 


6. On the main toolbar, click Customize > ArcCatalog Options and make sure 
your metadata style is FGDC CSDGM Metadata. 
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7. Click on the Description Tab to view the metadata.  Search through the 
metadata and find what these two attributes indicate.  
 


 
 
 


8. What does the coded “o” and “a” status attributes refer to? 
 
 _________________  
  
 _________________ 
 


TASK 3 – Creating Multiple Feature Classes from Multiple Shapefiles 


1. Next, let’s bring in a batch of shapefiles all at once to save time.  Right-click on 
the Hydrology feature dataset and select Import > Feature Class (multiple…). 
 


 
 


 


2. Click the browse folder  button and navigate to the Shapefiles folder.  Hold 
down the Ctrl Key and select the Ponds, Ponds_27, Springs, Streams and 


Watershed shapefiles.  Click  and . 
 


3. Examine the spatial reference for the NEW Ponds_27 feature classes by right-
clicking on each feature class and selecting Properties, then clicking on the XY 
Coordinates Tab.  What are the XY Coordinates for these layers? 


 Ponds feature class:_______________________ 


 Ponds_27 feature class:____________________ 
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4. Do the same for the Hydrology feature dataset.  The XY Coordinates should be 
the same as your feature classes. 
 


5. Now, examine XY Coordinates on the OLD Ponds and Ponds_27 shapefiles.  
What are the XY Coordinates for these layers? 
 
Ponds shapefile:_______________________ 
 
Ponds_27 shapefile:____________________ 
 


6. Click on the   button on the main toolbar in ArcCatalog to launch ArcMap and 
examine your new feature classes.   
 


7. Click on New Maps in the ArcMap Getting Started dialog.  Change your default 
geodatabase to NCTC and click OK.  
 


 
 
 


8. Click on the add data  button and browse up  to the Imagery folder.  
Add the Aerial_2009.sid file.    
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9. Add  the Ponds and Ponds_27 feature classes from the NCTC 
geodatabase. 
 


 
 
 


10. Do the ponds overlay correctly or is there a shift?______________. 
 


11. If the shapefile has an undefined coordinate system (i.e., does not have an 
associated projection .prj file) the shapefile will be imported into the feature 
dataset and assume what?_________________________________.   
 
The point here is that you need to have a projection defined for all your 
shapefiles before you perform a multiple/batch import.  The Ponds_27 shapefile 
was actually digitized in the NAD27 datum, not NAD83.   
 
The geodatabase will assign each imported layer whatever you have defined in 
the feature dataset, which can lead to large spatial errors.  It does not matter 
what projection you have for the shapefile, just as long as you have one.  The 
geodatabase will automatically transform the data into the spatial reference you 
have in the feature dataset.  
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TASK 3 – Performing SQL Queries while Importing Shapefiles 


Let’s import another shapefile into the NCTC geodatabase, but this time we’re going to 
clean-up the data during the import with an SQL query. 


1. Close ArcMap if you have not done so already. 
 


2. Right-click on the Transportation feature dataset and select Import > Feature 
Class (single…).  Input the trails_GPS_2008 feature from the shapefiles folder. 
 


3. Name the new feature class ntc_trails.  Continue onto the next step before 
finishing. 
 


4. Click the SQL   button to create a query. 
 


 
 
 


5. Create the query as shown below to include all the trails except Deer Stand 
Trails.  Click OK to return to the Feature Class to Feature Class dialog.   
 
To create the query, simply double click on the “NAME” field, single click on the 


does not equal sign <>, click on the  button, and double click on 
the “Deer Stand Trail” value. 
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6. Let’s clean-up the data a bit more before we finish the import.  Delete the last 5 
fields in the Field Map section using the delete button.  Click OK. 


 


7. Let’s clean-up the data a bit more before we finish the import.  Delete the 5 fields 
in the Field Map section as shown below using the delete button.  Click OK. 
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8. Look at the Table in the Preview tab to make sure the data was imported 
correctly. 
 


 
 


9. Repeat the same process above, but this time only import the Deer Stand Trails.  
Name the new feature class ntc_deer_stand_trails.   


 
 


TASK 4 – Importing XY Tabular Data 


1. Navigate to the Tables folder.  Maximize the NCTC excel file and highlight the 
NCTC_Signs$ worksheet.  The $ symbol indicates that it’s an excel worksheet. 
 


2. Look at the table in the Preview tab and notice that we already have a UTM_X 
and UTM_Y coordinate fields and we also know the datum and coordinate 
system. 
 


3. Right-click on NCTC_Signs$ worksheet and select Create Feature Class > 
From XY Table… 
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4. Change the Y Field to UTM-Y. 
 


 
 


5. Click on the browse button  in the output section and save your new feature 
class as ntc_signs in the Monitoring feature dataset.  Make sure to change the 
file type to “File and Personal Geodatabase feature classes”.  Click Save, then 
OK. 
 


 
 


6. Peruse your geodatabase.  Was ntc_signs added to the Monitoring feature 
dataset__________?  This is a strange quirk.  Use your mouse to drag and drop 
your new feature class into the Monitoring feature class. 
 


7. Right-click on the ntc_signs feature class and select Properties.  Click on the XY 
Coordinate System tab and notice that the proper datum and coordinate system 
was applied to the data. 
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8. Repeat the same table to feature class process, but this time save the feature 
class inside the geodatabase, not inside any feature dataset.  Use a different file 
name.  Look at the XY Coordinate System for this second feature class. Is it 
defined_______?   
 


9. How would you define the XY Coordinate System of a table during table to 
feature class process if you’re not saving it into a feature dataset? 
 


TASK 5– Importing a Feature Class  


We’re almost done.  Let’s import one more data type; a feature class from a file 
geodatabase.   
 


1. Right-click on the Transportation feature dataset and select Import > Feature 
Class (single…). 
 


2. For Input Features, click the browse  button and navigate to the 
Deer_Project geodatabase in the Projects folder. 
 


3. Select the ntc_hunter_parking feature class from the Deer_Hunt feature 
dataset.  Click the Add button. 
 


 
 


4. Name the Output Feature Class ntc_hunter_parking.  Click OK when done.  
 


5. Click on the Preview tab and examine the data you just imported. 
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TASK 6–Loading Data into a Feature Class 


This is an example where we mapped hunter parking lots on two separate occasions 
using GPS units.  We now have to do some data management to append the new data 
to our existing ntc_hunter_parking feature class. 


1. Right-click on the ntc_hunter_parking feature class you just imported.  Choose 
Load > Load Data.  Click Next on the first screen that appears. 
 


2. For input data, click browse  and navigate to the Deer_Project geodatabase 
in the Project folder.  Select the hunter_parking feature class. 
 


3. From the Simple Data Loader dialog, click Add to include the data in the List of 
source data to load field.  Click Next twice. 
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4. Click on the drop-down arrows for the <none> values in the Matching Source 
Field column and match-up the Source with the Target fields.  Note: any 
unmatched fields will be null in the appended records.  Click Next. 
 


 
 


5. Now, the important part.  We need to create a simple query to select only the 
records we want appended to our existing feature class.  Ensure that the “Load 
only the features that satisfy a query” is checked. 
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6. Click the Query Builder button and select only values that = 1 in the chgcode 
field.  Do you remember how to do this?   
 


7. Preview the ntc_hunter_parking feature class tabular data when done to make 
sure the records were appended. 


 


Congratulations!  You imported shapefiles, tables and future classes into your 
new file geodatabase. 
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SECTION 2 – Designing a New Geodatabase for a Specific Project 


 


Please read the project summary below first! 


 


Title: Invasive Plant Inventory 


Requested by:  Phil Pannill; Land Manager at NCTC  


Problem Statement:  


NCTC is plagued with an infestation of east coast weeds.  Phil Pannill, our trusted Land 
Manager, would like to conduct an inventory of the worst weed patches on the NCTC 
property.  Phil would like to document patch size and estimate percent cover of the 
weed species.  Permanent photo-point stakes should also be established at a sample of 
the most horrible sites and pictures taken to document the horror. 


Project Objectives: 


1. Map the invasive weeds on NCTC property over a 6 month period (May-Oct.). 
2. Establish permanent photo-point markers at the worst infested sites and take 


initial photographs. 


Existing Data: (D:\CSP7200\NCTC) 


1. Imagery\Aerial_2009.sid 
2. Tables\Weeds.xlsx 


Methodology: 


1. Create a file geodatabase with weed (polygon) and photo-point (points) feature 
classes. 


2. Create domains (i.e., drop-down pick lists) to speed-up data collection. 
3. Collect the data with ArcPad 10 on a 2008 series Trimble GeoXH GPS receiver. 
4. Create metadata using the project summary as a reference. 


Deliverables: 


1. A file geodatabase with feature classes, domains and metadata. 
2. Photographs of the most despicable infested sites. 
3. A map document (.mxd) and a detailed map printed on a large format printer.
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TASK 1–Create the Geodatabase Structure 


1. Remove the Feature Class Design Form in the back of this exercise.  This 
completed form will serve as your structural design template while working 
through the exercise. 
 


2. Right-click on the Project folder in ArcCatalog and select New > File 
Geodatabase.  Name the new geodatabase Weed_Project. 
 


3. Right-click on the new geodatabase (the can), choose New > Feature Dataset.  
Name the feature dataset Inventory. 
 


4. Assign the NAD83, UTM Zone 18 datum and coordinate system to the feature 
dataset.  Use “none” for the vertical datum. 
 


5. Right-click on the Inventory feature dataset and create a new feature class.  
Name the feature class Weeds_Area.  Make sure the data type is a Polygon 
Feature.  Click Next twice, keeping the default configuration setting. 
 


 
 
 


6. Following the Feature Class Design Form, create the first new field “GPS_Date”.  
Change the data Type to Date.  Keep the “Yes” in all the Allow NULL values 
field.  See the example below. 
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7. Continue creating new fields as listed in the data form.  Change the text field size 
in the field properties section as listed on the data form, but ignore the Domain 
Name and Default Value columns for now.  We’ll add those in the next section.   
 


8. Click the Finish button when done. 
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9. Next, create the Photo_Points feature class as shown on the data form.  


However, when you get to the blank fields screen, select the  button 
towards the bottom of the screen. 
 


10. Browse to the Weeds_Area feature class you just created.  Click Add. 
 


 
 


11. Delete the last five fields by selecting each field and hitting Delete on your 
Keyboard.  Add the Marked, Pic_ID and Picture fields as listed on the data form. 
 


12. Have the Picture raster field be managed by the GDB (i.e., the geodatabase). 
 


 
 


13. Click Finish when done.  You can import feature classes or tables to use as 
templates to speed things along.  No need to recreate the wheel. 
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TASK 2–Create the Domains 


According to our data form we need to add 4 domains to our geodatabase.  Let’s create 
the shortest domain by hand first, and then use ArcToolbox to add the rest from Excel 
worksheets. 


1. Right-click on the Weed_Project geodatabase (i.e., the can) and select 
Properties. 
 


2. Click the Domains tab.  Type “Marked” in the first cell and provide a description.  
Change the Field Type to Single Integer and the Domain Type to Coded Values 
by clicking on the far right end of the cell, which will pop-down a list of data types.  
Fill-out the Coded Values section as shown below. 
 


 
 







GIS Project Design I: Data Development and Management                                                                  2011 
U.S. Fish and Wildlife Service                        National Conservation Training Center 


 


Data Management and Geodatabase Design                                                                          24 


3. Click Apply and OK when done.  For longer lists, its best to type the attributes in 
an Excel worksheet then upload the values into domains using the Table to 
Domain Tool in ArcToolbox.  
 


4. Minimize ArcCatalog for a moment.  Open the Weeds Excel file in the Tables 
folder using Windows Explorer or MS Excel.  Familiarize yourself with the 
attributes on each of the worksheets.   
 


 
 


5. Add your last name to the Technician list worksheet just below “Other”.  Save 
the document and close Excel.  The next step will be to import the worksheets 
into the geodatabase as domains. 
 


6. Maximize ArcCatalog and open ArcToolbox  on the Standard Toolbar. 
 


7. Locate the Table to Domain tool in the Data Management Tools > Domains 
Toolbox.  Double tap on the Table to Domain to activate the tool. 
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8. Click browse  at the Input Table field and navigate to the Weeds Excel file in 
the Tables folder.  Double tap on the Weeds Excel file to view the worksheets.  
Select Technician$ and click the Add button. 
 


 
 


9. Using the dropdown list button on the end of each field, select the Technician for 
both the Code and Description fields (it’s the only column in the worksheet). 
 


10. For input workspace, browse  to the location of the Weeds_Project 
geodatabase and click Add. 
 


11. Accept the default Domain Name, which will be the “Technician” Excel column 
header.  Your screen should look like the one below.  Click OK when done. 
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12. Use the Table to Domain tool to import the GPS_Device and Weed_Species 
Excel worksheets.   
 


13. When you’re importing the Weed_Species worksheet, use the Weed_Code 
column for the Code Field and the Weed_Species column for the Description 
field.  Make sure to name the domain Weed_Species. 
 


14. Right-click on the Weed_Project geodatabase, select Properties and the 
Domains tab to verify the values were successfully imported and the domain 
names match those on your design form. 
 


 
 


15. Click OK when done. 
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TASK 3–Assign Domains to Fields  


1. Right-click on the Weeds_Area feature class and select Properties. 
 


2. Click on the Fields Tab. 
 


3. Select the GPS_Device field and specify the GPS_Device domain in the Field 
Properties section of the dialog. 
 


4. In the Default Value field type the default domain value listed on your design 
form.  Click the Apply button after you assign each domain.  Click OK when 
done. 
 


 
 


5. Finish assigning the domains to the remaining fields in both the Weed_Area and 
Photo_Points feature classes as listed on your design form.   
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TASK 4– Create Data in ArcMap 


1. Close ArcCatalog and Launch ArcMap . 
 


2. Open a New Blank Map and Add the Aerial_2009.sid layer from the Imagery 
folder. 
 


3. Add  the Inventory feature dataset and both layers will be loaded.  If the 
imagery is the top layer in the Table of Contents, just drag it down to the bottom 
of the list so you can see the point and polygon features once you start editing. 
 


4. Start and editing session from the Editor Toolbar. 
 


 
 


5. Select the Photo_Point layer in the Create Features Dialog and tap anywhere 
on the map to create a point. 
 


 


  







GIS Project Design I: Data Development and Management                                                                  2011 
U.S. Fish and Wildlife Service                        National Conservation Training Center 


 


Data Management and Geodatabase Design                                                                          29 


6. Click on the Attribute button in the Editor Toolbar to view and edit the Attribute 
table. 


 
 


7. What fields are automatically populated and why? 


_______________________ 


_______________________ 


_______________________ 


_______________________ 


 
8. Click on the value’s in each field.  Notice the drop-down menu’s in the fields that 


are auto-populated.  These are the domains that you created and assigned to 
each field.   The value’s that our auto-populated are the default values you gave 
to each domain.   
 


9. Why do you have a Yes in the Marked field when you gave it a “1” as a default 
_____________________________________________________________? 
 


10. Next we’re going to add a JPG raster image to the picture field to document our 
weed infestation status at the photo point.   Click on the <Null> value in the 
Picture field and select Load. 
 


11. Browse  to the file in the Picture folder.  Select any JPG file and click the Add 
button.  Click OK. 
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12. You should see the photo in Picture field on the Attributes table.  Now, you can’t 
do that with a #!%$# shapefile! 
 


 
 


13. Create a couple more points and load a photo into the picture field for each one. 
 


14. Create a new polygon in the Weeds_Area layer.  Examine the attributes  to 
make sure all the assigned domains are working properly. 
 


 
15. Stop editing, save edits and close ArcMap. 







GIS Project Design I: Data Development and Management                                                                  2011 
U.S. Fish and Wildlife Service                        National Conservation Training Center 


 


Data Management and Geodatabase Design                                                                          31 


Feature Class Design Form 


Feature Class or Table Name  Data 
Type  Field Name  Field Type  Text 


Length  Domain Name  Default Value 


Weeds_Area  Polygon  GPS_Date  Date          


      GPS_Device  Text  20  GPS_Device  GeoXH 


      Technician  Text  35  Technician  "your last name" 


      Weed_Species  Text  35  Weed_Species    


      Percent_Cover  Floating          


      Comments  Text  40       


                    


Photo_Points  Point  GPS_Date  Date          


      GPS_Device  Text     GPS_Device  GeoXH 


      Technician  Text     Technician  "your last name" 


      Marked  Short Int      Marked  1 


      Pic_ID  Text  25       


      Picture  Raster          
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Exercise 3 – Creating, Exporting and Importing Metadata  


 
 
Session Objectives:  At the conclusion of this session, you will be able to: 
 
 
 Create new metadata for geodatabase feature class using ArcCatalog. 


 


 Export and Import metadata from a geodatabase feature class using 
ArcCatalog 10. 
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Material Created By:  Eric Kelchlin (October 2011) 


Revision:  


Software:  ArcGIS 10 SP2 


Directory Path: D:\CSP7200\Exercise3 


Data: Weed_Project_Summary.docx 


GDB: Weed_Project.gdb 
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SECTION 1 – Creating Metadata in ArcCatalog 10 
 
In this section, you will utilize the metadata editor in ArcCatalog 10 to generate “quick 
and dirty” metadata for your data layer.  Not all the mandatory fields are populated, only 
the bare minimum.  It’s possible and recommended to paste text from reports into text 
fields.  A GIS project summary report would be perfect fodder for metadata! 
 
All data are located in the D:\CSP7200\Exercise3 folder. 
 


1. Launch ArcCatalog  from the desktop.  
 


2. From the Customize menu, select ArcCatalog Options.   
 


3. Click the Metadata tab and change the metadata style is FGDC CSDGM 
Metadata.   Also make sure that the metadata updates box is checked as shown 
below.  Click OK. 


 


 
 


4. In the catalog tree on the left hand side of the screen, navigate to the 
Weed_Project.gdb in the Exercise3 folder.  This is a copy of same dataset you 
worked on yesterday. 


 
5. To start editing metadata, simply highlight the Structures feature class, select the 


Description tab and select the Edit tool  in the Items Description window.   
See the example on the next page.  


 
  







GIS Project Design I: Data Management and Development                                                                  2011 
U.S. Fish and Wildlife Service                              National Conservation Training Center 


 


Metadata                                                                                      4 
 


 
 


 
7. Click Item Descriptions in the Overview section and fill-in the following items: 


 
 
Tags – add subject keywords separated by commas. 
 
USFWS, NCTC, Weeds, Inventory, Trimble GeoXH 
 
 
Summary – add a brief summary of the data. 
 
GPS field data collected as part of the GIS Project Design I class 
(CSP7200) in December 2011.  Data were collected via a Trimble GeoXH 
2008 series GPS receiver running ArcPad 10, Service Pack 2.  Averaging 
was enabled (10 seconds for points, 5 seconds for vertices).  A 2 second 
logging rate was used for streaming line and polygon features.  WAAS 
was enabled to improve accuracy.  No PDOP limit was applied. Mission 
planning was not conducted.  Data were Post-processed using Pathfinder 
Office 5.10. 
 
 
Description – add an abstract explaining its data and purpose.   Open and copy 
the text in the Inventory_Project_Summary Word document in Exercise 3 and 
paste in this field. 
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Note:  you can also add a hyperlink to any web document.  To do this, type a 


word like “Description”, then highlight the text and click the hyperlink tool .  
Next copy and paste this web address in the field and click Apply. 
 


 
Credits – add the person(s) name or organization name. 
 
USFWS National Conservation Training Center 


 
Use Limitations – add the following statement: 
 
Although these data and information have been processed successfully 
on a computer system at the USFWS, no warranty expressed or implied is 
made regarding the accuracy or utility of the data and information on any 
other system or for general or scientific purposes, nor shall the act of 
distribution constitute any such warranty. This disclaimer applies both to 
individual use of the data, and information, and aggregate use with other 
data and information. It is also strongly recommended that careful 
attention be paid to the contents of the metadata file associated with 
these data and information. The USFWS shall not be held liable for 
improper or incorrect use of the data and information described and/or 
contained herein.  
 
 


8. Select Topics & Keywords and fill-out the following sections: 
 
Topics - check the Biota and Environment boxes 
 
Theme Keywords – type keywords separated by commas 
 
Weeds, Inventory, Photo Points 
 
Place Keywords - type keywords separated by commas 
 
National Conservation Training Center, WV 


 
 


9. Click on Citation Contacts and type your contact and contact information.  
 
 


10. Click on Details in the Resource section and change the Status to Completed. 
 


11. Click the Save button  when finished.   
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12. To add a thumbnail image to your metadata, simply click on the Preview Tab 
and select the Add Thumbnail icon on the Geography Toolbar.  Click back on 
the Details Tab to view the thumbnail. 
 


 


 
 
 
 


Congratulations!  You just created metadata for your GIS data. The next sections 
show how you can export this information and use it as a metadata template for 
other datasets to save time. 


 
 
SECTION 2 – Exporting Metadata in ArcCatalog 10 
 
 


1. Highlight the Photo_Points layer and select Export from the Description Tab. 
 


 
2. Use the ArcGIS2FGDC.xml translator and save your file as Metadata_Template 


in the Exercise3 folder.  See the example below.  You will need to type the .xml 
extension in the file name! 
 


 
 
 


3. Click OK and Close.  You should see the 
Metadata_Template file in your table of 
contents.  If not, then click View > Refresh on 
your main toolbar. 
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SECTION 3 – Importing Metadata in ArcCatalog 10 
 


1. Highlight your source layer, use Weeds_Area for this example, and select 
Import from the Description Tab. 
 


 
 


2. Change the Import Type to FROM-FGDC and click OK and Close.  You will have 
some green errors because not all the mandatory FGDC fields are filled-out. 
 


 
 


 
3. View your new metadata.  Did everything come over correctly?  
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Exercise 4 – Working with Tables  
 


 


Session Objectives:  At the conclusion of this session, you will be able to: 


 


 Use ArcGIS and MS Access to clean-up a long-term monitoring and inventory 
datasets. 
 


 Restructure a flat table into a relational database with multiple related tables. 
 


 Use ArcMap to view, query and analyze data in related tables. 
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Material Created By:  Eric Kelchlin (November 2011) 


Software:   ArcGIS 10, SP3 


Data Path:  D:\CSP7200\Exercise 4 


Databases:  Bombayhook.gdb, PlantData.mdb, Database1.mdb (from scratch) 


Tables:  USDAPlants.xlsx 


MXD:   Exercise4.mxd 
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Data Management 


In this Exercise, you will utilize ArcGIS and/or MS Access to clean-up a 15 year long 
wetland monitoring dataset from Bombay Hook National Wildlife Refuge.  The dataset 
contains location information on sample sites (n=221), saltmarsh vegetation species 
and percent cover values that are expressed as Daubenmire cover class mid-points. 


What is data clean-up?  Data clean-up is a structured hierarchical evaluation of the 
dataset(s) to find errors and redundancies.  The objectives are project specific but they 
typically involve searching for and fixing typing errors, deleting records that are 
redundant or essentially useless for data analysis, merging similar records (this is no 
time to be a splitter!), recoding values and restructuring the table for data analysis. 


Long-term monitoring and inventory datasets are plagued by errors because the 
sampling protocol and sampling intensity changes annually due to employee turnover 
and short-sighted funding.   Observer bias can also be a major problem with long-term 
data sets.  Some field technicians are more skilled at plant and animal identification 
than others, which results in a dataset rich with species diversity in some years and just 
deplorable in other years.   


The goal of this project is to monitor salt marsh plant species composition and percent 
cover changes though time.  Our goal is to clean-up the dataset, restructure the flat 
table into a relational database with multiple related tables and examine plant species 
trends. 


 


All data are located in the D:\CSP7200\Exercise4 folder.  A copy of the Bombayhook 
geodatabase is located in the Original folder if you want to complete both the ArcGIS 
and MS Access sections.  


 


  


MS Access  ArcGIS 
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Task 1 – Data Clean-up 


1. Open the Exersize4.mxd. 
 


2. Open the attribute table and examine the dataset.  The field names are really too 
long and is likely an artifact from a past merging of data sets.  I see a lot of 
repetitive fields and some missing midpoint data as well.  The most important 
data fields are: 
 


 sample sites (Im_Biol_Monit_Sites_Pt_Pt_Name),  
 when sampled (“_growyear)  
 plant species (“_comname, “_genus, _”species,”_sciName), and  
 percent cover estimate (“_Midpoint). 


 
3. Let’s create a new point feature class that contains the sample sites location and 


unique ID information.  This will serve as the primary table for data joins later-on 
in the exercise.   
 
Click on the Geoprocessing toolset from the main toolbar and select Dissolve.  
Change the fields to what is shown below.  Click OK.  The new Sampling_Sites 
feature class will be added to the Table of Contents. 
 


MS Access  
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4. Open the Im_ImpoundVeg_1991to2007 Attribute Table.  How many records are 
in this table ____________?   
 


5. How many records are in the Sampling_Sites table ____________?  So, you 
can now see that for every plant recorded in the field, a separate point was 
created to add the data. This is a very poor database design.  The annual 
monitoring data should be linked the Sampling_Sites feature class to create a 
relational database. 
 
Long-term monitoring datasets are best stored and summarized in an MS Access 
relational database.  Information you want spatially viewed in ArcMap can easily 
be added to the Table of Contents using on OLE Database Connection and then 
joined to feature classes. 
 
 


6. Open the Sampling_Sites attribute table to clean-up the data.  Add a new field 


from the Table Options button   .   
 


 Name this new text field Sampling_Sites.  Use a length of 10. 
 


 
 


 Next, right-click on the Sampling_Sites field and select Field Calculator.  
Copy the values from the neighboring field by simply double-clicking on 
the Im_Biol_Monit_Sites_Pt_Pt_Name field.  Click OK. 
 
 


 Right-click and delete the 
old field.  Close the table. 
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7. Open the Im_ImpoundVeg_1991to2007 Attribute Table.  Click on the Table 


Options button   .   Export the data as a Text file.  Name the file Data and 
save in the MSAccess folder. 
 


 
 
 


8. Save your map document.  Minimize ArcMap and open MS Access   . 
 


9. Click on the Options button in the lower left corner of the screen and change the 
default database location to Exercise4. 
 


  
10. Double-click on the Blank database button to start a new database.  The 


database is automatically named database1.mdb and saved in the Exercise4 
folder. 
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11. To import the text file, simply click External Data on the main toolbar and select 
Text File.  Browse to the Data.txt file, select and click Open.  Click OK. 
 


 Click Next to keep the Delimited format. 
 
 Check the First Row Contains Field Names box.  Click Next. 


 


 
 
 


 Click Next to keep the all the fields.  
 


 Click Next to have MS Access generate a Primary Key. 
 


 Click Finish to complete the import process. 
 


12. Next we’re going to create a query to remove all midpoint records with null values 
and clean-up the data.  Click Create on the main toolbar and select Query 


Design button . 
 


13. Select the Data table, click  and .  Stretch the table out to 
view all the field names. 
 


14. Double-click on the 8 fields shown below to add them to the query.  The order 
does matter, so add the fields from the top down. 
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15. Sort the first two columns in ascending order. 
 


 
 


16. Type the following query in the Criteria section of the Midpoint field to remove 
records with no data. 


 


 


17. Click the Make Table Query button   Name the table Data1.  Click OK.  
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18. Click Run!   to save the records to a new table. 
 
 


19. Right-click on the Query1 tab and select Close.  No need to save the query.  
Close the Data tab as well. 
 


 
 


20. Right-click on the Data1 Table and select Design View.  Change the field names 
to what is shown below.  Also change the text fields to a size of 35 in the Field 
Properties section at the bottom of the screen.  Note that you can add 
descriptions to each field as well. 
 


 
 


21. Click the Table View button  .  Click Yes twice.  No text fields are longer 
than 35 characters, so you won’t loose any data. 
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Task 2 – Group and Summarize  


Multiple samples/transects were taken at the same sample sites in some years.  This 
could be an artifact of different sampling protocols, but we really don’t know why.  The 
best we can do is calculate a mean midpoint value for each sample site, relative to year 
and plant species.  


1. Scroll down the table and see that the dataset contains multiple subsamples for 
each sample site within each year.  The dataset has yet to be summarized by 
sample site, year and plant species.  


 


2. Let’s first check for errors in the plant species fields before we do any 
calculations.  To do this, create another query by clicking Create on the main 
toolbar and selecting Query Design.   
 


3. Add the Data1 table to the query. Double-click on the 4 plant species fields as 


shown below to add them to the query.  Click on the Totals button  to add 
the Group By in the Total field.  Sort all the fields in ascending order. 
 


 
 


4. Click Run!   Make the columns wider to see all the text by dragging the right side 
of each column header. 
 


5. Right-click on the Query1 tab and save the query as Plants. 
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6. I can see two instances where the plant species need to be merged.  Arrowhead 
and Duck potato are the same species (Broadleaf Arrowhead, Sagittaria 
latifolia), and Millet and Walter Millet are also the same species (Water Millet, 
Echinochloa walteri). 
 


7. Click the Design View button    .  Remove the Group By in the Total field by 
clicking the Totals button again.  Add the following criteria to the query 
“Arrowhead” Or “Duck potato”.  Click Run!  (Note: it’s not case sensitive) 


 


 


8. Highlight the Common_Name field by clicking on the column header.  Click the 


Replace button     next to the binoculars and fill-in the fields as shown 
below.  Click Replace All and Yes to accept the changes. 
 


 
 


9. With the Find and Replace dialog still open, simply change the Find What field to 
“Duck potato” and click Replace All.  Click Yes to accept your changes. 
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10. Highlight each field sequentially and replace the text in the Genus, Species and 
Scientific_Name fields with the “Sagittaria”, “latifolia”, and “Sagittaria latifolia”, 
respectfully.  Your table should look like this when done. 
 


 
 


11. Go back to your Design View and change the query to “Millet” Or “Walter 
Millet”.  Click Run! 
 


12. Using the Find and Replace Tool, make sure the text in the Common Name, 
Species and Scientific_Name fields are changed to “Water Millet”, “walteri”, and 
“Echinochloa walteri”, respectfully.  The text in the Genus field is correct, so 
you can skip this one. 
 


 
 


13. Click on Design View.  Change the query back the way it was to include the 
Group By in the Totals field.  Remove the text in the Criteria field.  Click Run! 
You should have 72 plant species, if not, check for errors and go back to replace 
any incorrect records. 
 


14. With the errors fixed in the plant species, we can now go ahead and summarize 
the data.  To do this we need create a new query.   Save and close your existing 
Plant query first, just to clean things up a bit. 
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15. Click on the Query Design button and add the Data1 table to the query.   
 


 Add the Sample_Site, Growyear, Common_Name and Midpoint fields 
to the query. 
 


 Click the Totals button to summarize the data by Sample_site, Growyear 
and Common_Name….in that order. 


 
 Sort the data in ascending order. 


 
 Change the Group By in the Midpoint field to Avg (e.g., arithmetic mean).  


Click Run! 
 


 
 


16. How many records out of the 50,423 do you have now___________? 
 


17. This dataset is nice and clean, so let’s make it a new table for use in ArcGIS.  
Click the Design View button, select the Make Table query button.  Name the 
table Data_Sum and click Run!   
 


18. We need to make one more table.  This one will contain all the plant species 
names and other information that would be useful for grouping/summarizing data.  
Luckily this table is already completed and in a Excel format, so all you need to 
do is import the table. 
 


 To import an Excel spreadsheet, simply click External Data on the main 
toolbar and select Excel File.  Browse to the USDAPlants.xlsx file, select 
and click Open.  Click OK. 


 
 Select the USDAPlants worksheet. Click Next. 
 
 Check the “First Row Contains Field Names” box.  Click Next. 


 
 Click Next to keep the all the fields.  


 
 Click Next to have MS Access generate a Primary Key. 


 







GIS Project Design I: Data Development and Management                                                                   2011 
U.S. Fish and Wildlife Service                         National Conservation Training Center 


 


Tables                                                                                   14 


 Keep the table name and click Finish to complete the import process. 
 


19. Double-click on the USDAPlants table and view the data.  These data were 
downloaded from the National Resource Conservation Service online plant 
database (http://plants.usda.gov/). The download was specific for all plants in 
the state of Delaware.   
 


20. Save  the database and close Access.  Keep the default file name of 
Database1.mdb. 


 
 


Task 3 – Creating a Relational Database 


Creating relational databases is all about relating tables and feature classes together 
using a common field for the purpose of viewing or extracting data across multiple 
datasets.  This design strategy creates a stair-stepped hierarchical data structure, which 
is in stark contrast to the “flat” mega-tables that scroll-on forever.   


 
1. Open ArcCatalog. 


 
2. We need to import the Access tables we just created into our Bombayhook 


geodatabase.  This requires an OLE Database Connection.   
 


 To establish the connection, scroll down to Database Connections in the 
Catalog Tree.  Double-click on the Add OLE DB Connection. 
 


 
 


 Highlight the Microsoft Office 12.0 Access….Provider.  Click  
 


 Add the following path in the Data Source field:  
D:\CSP7200\Exercise4\Database1.mdb 


 


 Click the Test Connection button  to see if it works first, and 
then finish with the OK clicks. 
 


 Double-click on the new OLE DB Connection to make sure the 
connection is active and view the tables. 
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3. Now that we’ve established a connection to the database, import the Access 
tables by right-clicking on the Bombayhook geodatabase and selecting 
Import > Table (multiple).   
 
 Browse to the OLE DB Connection and select all three tables.  Click Add 


and OK. 
 


 
 


 Close the Input Table dialog.  Expand the Bombayhook geodatatabase to 
see if your tables were imported correctly.  
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Task 4 – Creating a Relational Database 


Creating relational databases is all about relating tables and feature classes together 
using a common field for the purpose of viewing or extracting data across multiple 
datasets.  This design strategy creates a stair-stepped hierarchical data structure, which 
is in stark contrast to the “flat” mega-tables that scroll-on forever.   
 


1. First, let’s delete redundant data.  Delete the Im_ImpoundVeg_1991to2007 
feature class.  All the data we need is in the Data_Sum table.  The Data1 table is 
the clean archived dataset, which is always good to keep just in case you need to 
go back and analyze the raw data in a different way. 
 


 Preview the Data_Sum table and delete the Genus, Species, 
Scientific_Name and cnt_Impoundment fields.  Do this by simply right-
clicking on the field header and selecting Delete. 


 
2. Next, we’re going to create two relationship classes to link the Sampling_Sites 


feature class to the Data_Sum table, and then Plant_List to the Data_Sum 
table. 


 Right-click on the Vegetation feature dataset and select New > 
Relationship Class.  
 


 Name the relationship class Sites_to_DataSum and select 
Sampling_Sites for the Origin and Data_Sum for the Destination. 
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 Keep the default Simple (peer to peer) relationship.  Click Next twice, 
keeping the defaults on the next screen as well. 
 


 Select the one to many relationship.  Click Next twice, keeping the 
defaults on the next screen as well 


 


 
 


 Select the Sampling_Sites field as the primary and foreign key.  This will 
link the table together.  Click Next and Finish. 


 


 
 


 Create the second relationship class, linking the Plant_List table with 
Data_Sum.  Right-click on the “Can” this time to create the new 
relationship class; where you create the relationship depends on the 
location of the tables in the geodatabase. 
 


 Name this relationship PlantList_to_DataSum.  This will be a one to 
many relationship as well. 
 


 What origin and foreign key will you use_____________________? 
 
 


3. Close ArcCatalog when done.   


 


Proceed to Task 5 on page 30 to finish the exercise. 
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Task 1 – Data Clean-up 


22. Open the Exersize4.mxd. 
 


23. Open the Attribute Table and examine the dataset.  The field names are really 
too long and is likely an artifact from a past merging of data sets.  I see a lot of 
repetitive fields and some missing midpoint data as well.  The most important 
data fields are: 


 
 sample sites (Im_Biol_Monit_Sites_Pt_Pt_Name),  
 when sampled (“_growyear)  
 plant species (“_comname, “_genus, _”species,”_sciName), and  
 percent cover estimate (“_Midpoint). 


 
24. Let’s create a new point feature class that contains the sample sites location 


and unique ID information.  This will serve as the primary table for data joins 
later-on in the exercise.   


 
 Click on the Geoprocessing toolset from the main toolbar and select 


Dissolve.  Change the fields to what is shown below.  Click OK.  The new 
Sampling_Sites feature class will be added to the Table of Contents. 
 


 
 


ArcGIS 
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25. Open the Im_ImpoundVeg_1991to2007 Attribute Table.  How many records 
are in this table ____________?   


 
26. How many records are in the Sampling_Sites table ____________?  So, you 


can now see that for every plant recorded in the field, a separate point was 
created to add the data. This is a very poor database design.  The annual 
monitoring data should be linked the Sampling_Sites feature class to create a 
relational database. 


 
NOTE: Long-term monitoring datasets are best stored and summarized in an MS 
Access relational database.  Information you want spatially viewed in ArcMap 
can easily be added to the Table of Contents using on OLE Database 
Connection and then joined to feature classes. 
 


27. Open the Sampling_Sites attribute table to clean-up the data.  Add a new 


field from the Table Options button   .   
 


 Name this new text field Sampling_Sites.  Use a length of 10. 
 


 
 


 Next, right-click on the Sampling_Sites field and select Field Calculator.  
Copy the values from the neighboring field by simply double-clicking on 
the Im_Biol_Monit_Sites_Pt_Pt_Name field.  Click OK. 
 
 


 Right-click and delete the 
old field.  Close the table. 
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28. Let’s create a new table, load only the data we want, and fix many issues in 
one step.  


 
 Open ArcCatalog from the docked sidebar.   


 
 Right-click on the Bombayhook geodatabase and create a new Table.  


Name it Data1.  Create the table structure as listed below: 
 


Field Name Data Type Text Length 


Sample_Sites Text 10 


Impoundment Text 35 


Growyear Double  


Common_Name Text 35 


Genus Text 35 


Species Text 35 


Scientific_Name Text 35 


Midpoint Double  


 


29. In ArcCatalog, right-click on the Data1 table and select Load Data. 
 


 Use the Im_ImpoundVeg_1991to2007 feature class as the input dataset. 
 


 Match the Source fields with the Target fields, click Next once. 
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 Build a SQL query    to remove the midpoint records with 
Null values.  See the exmaple below.  Click OK and Finish. 


 


 
  


Task 2 – Group and Summarize  


Multiple samples/transects were taken at the same sample sites in some years.  This 
could be an artifact of different sampling protocols, but we really don’t know why.  The 
best we can do is calculate a mean midpoint value for each sample site, relative to year 
and plant species.  


1. Right-click and sort ascending on Sample_Sites.  Notice that the dataset 
contains multiple subsamples for each sample site within each year.  The dataset 
has yet to be summarized by sample site, year and plant species.  


 


2. Let’s first check for errors in the plant species fields before we do any 
calculations. To do this, right-click on the Common_Name field header and 
select Summarize.  Save the table as Plant_sum as shown below. 
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3. Add the new table to your Table of Contents and view the results. 


 
4. I can see two instances where the plant species need to be merged.  Arrowhead 


and Duck potato are the same species (Broadleaf Arrowhead, Sagittaria 
latifolia), and Millet and Walter Millet are also the same species (Water Millet, 
Echinochloa walteri). 
 


5. To change the plant names we need to perform a Select by Attributes Query 
and then use the Search & Replace Tool on the selected records. 
 


 Close the Plant_sum table and open the Data1 table.   
 


 Click on the Select by Attributes button   .    
 


 Create and run the following query:  "Common_Name" = 'Arrowhead' 
OR "Common_Name" = 'Duck potato' 


 


 Click on the Show selected records  button at the bottom of the 
table. 
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 Start and editing session.  Click on the Table Options button and select 
Find & Replace. 


 


 
 


 Click on the Replace Tab and fill-in the fields as shown below.  Click 
Replace All. 
 


 
 


 Next, type “Arrowhead” in the Find what field and hit Replace All again.  
This completes the changes we needed to make for the Common Name 
field.   
 


6. Finish correcting the text in remaining three plant name fields (Species, Genus 
and Scientific_Name), with Sagittaria, latifolia, and Sagittaria latifolia, 
respectively. 
 


7. Use the same process as above; replace the Millet and Walter Millet common 
names with Water Millet.  Also change the Species and Scientific_Name fields 
to “walteri”, and “Echinochloa walteri”, respectfully.  The text in the Genus field 
is correct, so you can skip this one. 
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8. Clear all selections  and Show all records .  Stop Editing and Save you’re 
edits. 
 


9. Summarize the Common_Name field again and save the table as Plant_sum2.  
You should have 72 plant species, if not, check for errors and go back to 
replace any incorrect records. 
 


 
 
 


10. With the errors fixed in the plant species, we can now go ahead and calculate an 
average midpoint value to account for multiple subsamples/transects seen in the 
Impoundment field.   
 


 From the XTools Pro Toolbar, select Table Operations > Aggregate 
Features/Records. 
 


 
 


 Select the Data1 Standalone table.  Click Next. 
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 Select the 6 grouping fields as shown below.  Click Next. 
 


 
 


 Check the Count box for the Impoundment field and the Avg box for the 
Midpoint field.  Click Next. 
 


 Save the table in the Bombayhook geodatabase.  Name the table 
Data_Sum. 
 


 
 


 
11. How many records out of the 50,423 do you have now____________? 
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Task 3 – Integrating Microsoft Access Data  


We need to make one more table.  This one will contain all the plant species names and 
other information that would be useful for data grouping.  Once this table is done, we 
can go back into the Data_Sum table and remove all the plant name fields except for 
Common_Name, which will serve as the key lookup field in the relationship class.  
Luckily the plant table is already completed and all you need to do is import it into the 
geodatabase. 


1. Close ArcMap, don’t save the document, and Open ArcCatalog from the desktop.  
 


2. Let’s clean things up a bit before we proceed.  View the Bombayhook 
geodatabase.  Delete all tables except Data1 and Data_Sum. 
 


 
 
 


3. The table you’re going to import is an MS Access table, which requires an OLE 
Database Connection.   
 


 To establish the connection, scroll down to Database Connections in the 
Catalog Tree.   Double-click on the Add OLE DB Connection. 
 


 
 


 Highlight the Microsoft Office 12.0 Access….Provider.  Click  
 


 Add the following path in the Data Source field:  
D:\CSP7200\Exercise4\PlantData.mdb 


 


 Click the Test Connection button  to see if it works first, and 
then finish with the OK clicks. 
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 Double-click on the new OLE DB Connection to make sure the 
connection is active and view the tables. 
 


 
 


4. Now that we’ve established a connection to the database, import the Plant_List 
table by right-clicking on the Bombayhook geodatabase and selecting Import > 
Table (single).  Populate the fields as shown below.  Click OK. 
 


 
 
 


5. Preview the Plant_List table you just imported. 
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Task 4 – Creating a Relational Database 


Creating relational databases is all about relating tables and feature classes together 
using a common field for the purpose of viewing or extracting data across multiple 
datasets.  This design strategy creates a stair-stepped hierarchical data structure, which 
is in stark contrast to the “flat” mega-tables that scroll-on forever.   
 


4. First, let’s delete redundant data.  Delete the Im_ImpoundVeg_1991to2007 
feature class.  All the data we need is in the Data_Sum table.  The Data1 table is 
the clean archived dataset, which is always good to keep just in case you need to 
go back and analyze the raw data in a different way. 
 


 Preview the Data_Sum table and delete the Genus, Species, 
Scientific_Name and cnt_Impoundment fields.  Do this by simply right-
clicking on the field header and selecting Delete. 


 
5. Next, we’re going to create two relationship classes to link the Sampling_Sites 


feature class to the Data_Sum table, and then Plant_List to the Data_Sum 
table. 


 Right-click on the Vegetation feature dataset and select New > 
Relationship Class.  
 


 Name the relationship class Sites_to_DataSum and select 
Sampling_Sites for the Origin and Data_Sum for the Destination. 
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 Keep the default Simple (peer to peer) relationship.  Click Next twice, 
keeping the defaults on the next screen as well. 
 


 Select the one to many relationship.  Click Next twice, keeping the 
defaults on the next screen as well 


 


 
 


 Select the Sampling_Sites field as the primary and foreign key.  This will 
link the table together.  Click Next and Finish. 


 


 
 


 Create the second relationship class, linking the Plant_List table with 
Data_Sum.  Right-click on the “Can” this time to create the new 
relationship class; where you create the relationship depends on the 
location of the tables in the geodatabase. 
 


 Name this relationship PlantList_to_DataSum.  This will be a one to 
many relationship as well. 
 


 What origin and foreign key will you use_____________________? 
 


6. Your geodatabase should look like this below.   Close ArcCatalog when done. 
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Task 5 – Working with Related Tables in ArcMap 


Now with all that grunt work behind you, let’s explore the related data and do some 
simple analyses. 
 
Viewing Related Tables 
 


1. Open a new blank map in ArcMap and Add the Sampling_Sites feature 
class.  The tables remain in the geodatabase, but the data are accessible 
because of the defined  relationships. 
 


2. You can view the related tables by using the identity tool  to see the data 
specific to each sampling site, or through the attribute table to see all the 
records. 


 


 Click on the identity tool  on the Tools toolbar.  Select any sampling 
site.  Notice that the data are structured in multiple levels.  Each level has 
its own attribute table that can be explored by clicking the plus  symbol. 
 


 
 


 Close  the Identify dialog and open the Sampling_Sites attribute table.
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 Click the Related Tables button  and select the Sites_to_DataSum 
relationship class on the list.  Notice the new tab at the bottom of the table; 
you now have multiple tables opened-up at the same time. 
 


 
 


 Click the Show all records button  to view the data.  ArcMap defaults to 


show the selected records only, so get into the habit of clicking the  
button as soon as you open a related table. 
 


 
 


 Click on the  button again and select the PlantList_to_DataSum 


relationship class on the list.  Show all the records .  The process of 
opening related tables must be done in logical tiered steps.  In this 
example the logical order is to go from sample sites to sample data and 
then sample data to the plant species data.  
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Analyzing Data from Related Tables 


Viewing the data is fairly straightforward, but analyzing the data from related tables 
requires a few more process steps.  For example, let’s say you want to calculate an 
average percent cover estimate for Graminioids in 1992 and graphically display the data 
on a map.  The process of doing this analysis will involve joins, queries and 
summarizing the results in a new table. 


 
1. The first step is to join the Data_Sum and Plant_List tables.  Unlike MS 


Access, you can’t perform a multiple table query in ArcGIS, so you’re forced to 
use a join. 


 


 Close  the attribute table if you have not done so already. Right-click 
on the Data_Sum table in the Table of Contents and select Joins and 
Relates > Join. 
 


 Join data based on a pre-defined relationship class and select the 
Plant_List  relationship as shown below.  Keep all the records. Click OK. 
 


 
 


 Open the Data_Sum table and scroll over to see if the join was 
successful.  You should have a whole bunch of new fields after the 
avg_Midpoint field. 
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2. Next, click on the Select by Attribute button     in the open table.  Create a 
query to select only records containing Graminoids  in 1992.  You should have 
972 records selected. 


 


 Close the query and view only the selected records .  
 


 
 


3. Calculate an average midpoint value by sample sites.  To do this, right-click on 
Sample_Sites and select Summarize. 


 
 Scroll down the list of fields and check the Average box under the 


Data_Sum.avg_Midpoint field.  Name the table Graminoids_1992.  Click 
OK and add the data to the map. 
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4. Right-click on the Sampling_Sites table and join it to the Graminoids_1992 
table as shown below. 
 


 
 


 Click on the Validate Join button   to make sure the join 
will work properly.  Often a join will fail because field headers contain 
invalid characters such as a period “.” or a reserved word such as 
“Percent”.  So it’s a good habit always validate you joins.   
 


 Click OK to complete the join.   
 


5. Finally, let’s symbolize each sample point based on the average Midpoint 
value to quickly to visualize trends in Graminoid plant species.  
 


 List your data by drawing order  in your Table of Contents. 
 


 Right-click on the Sampling_Sites feature class and select Properties > 
Symbology tab.  Change the symbol type to Proportional Symbols and 
use the Average_avg_Midpoint value.  Click OK. 
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 This symbology will give you a rough idea where Graminoids are more 
prevalent in the impoundments.     
 


 Change the Symbology to the Graduated symbols this time and 
Normalize the data with the Count_Sample_Sites field.  Can you see 
patterns now? 


 


 Add  a Bing base map to help with your interpretation.  
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Exercise 5 – Working with LIDAR and Terrain Datasets  


 
 
Session Objectives:  At the conclusion of this session, you will be able to: 
 
 
 Determine properties of raw LiDAR data and load into a geodatabase 


 


 Build a terrain dataset to visualize LiDAR data 
 


 Create a DEM and contour derivatives 
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Material Created By:  Dan Craver (November 2011) 


Revision:  


Software:  ArcGIS 10 SP3 


Directory Path: D:\CSP7200\Exercise5 


Data: \Data 


GDB: NCTC_Terrain.gdb 


MXD: NCTC_Terrain.mxd 
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SECTION 1 – Determine Properties of Raw Lidar Data & Load Into a Geodatabase 
 
In this section, you will utilize ArcMap to explore the properties and calculate statistics of 
raw LiDAR data, identify a subset or Area of Interest, load as a multipoint feature class 
for terrain construction, and evaluate errors and point density for project suitability.   
 
All data are located in the D:\CSP7200\Exercise5 folder. 
 
 
1. Open Windows Explorer and navigate to \Data folder containing the raw LiDAR 


data and project documentation.  
 


 
 


2. Open and review the project documentation. 
 


3. Open one of the .txt files with Notepad and examine the data structure.   
 


 
 
What is included?  What is not?  Why is the data split among several files? 
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4. Navigate to NCTC_Terrain.MXD in the project folder and open with ArcMap. 
 


 
 
5. Notice the vector reference data has already been loaded for you as a group layer 


in the Table of Contents  .   
 


6. We will need recent imagery to help define our project boundary and evaluate the 
data.  Load aerial imagery from the local NCTC data resources OR provided 
suitable bandwidth, in ArcMap choose the drop down arrow next to the Add Data 
button and select Add Basemap. 


 


 
 


Add Bing Maps Hybrid.  Dismiss the coordinate system warning.  You may want 
to turn off the basemap when not in use to preserve ArcMap performance. 
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7. If not already, open the ArcCatalog window  and the Search window  
using icons found on the standard toolbar.  You may want to dock these windows 


and auto-hide as tabs for occasional retrieval using the push-pin icon . 
 


8. In ArcCatalog, select connect to folder  and navigate to the project folder 
CSP7200\Exercise5.  Right click on the file geodatabase NCTC_Terrain.gdb and 
Make Default Geodatabase.  This is where the Reference_Data is located, we 
will store out LiDAR data, and build our terrain. 


 


 
 


 
9. Right click on the geodatabase and create New > Feature Dataset with the name 


Terrain_Dataset and XY and vertical coordinate system matching project 
requirements.   
 


 Set the XY and Z tolerance to 0.1 and uncheck “Accept default 
resolution and domain extent.”   
 


 Set the XY and Z resolution to 0.01 and Finish.  The resolution controls 
space requirements of the geodatabase.  By examining the raw data we 
determined the measurements are made to the hundredth of a meter.  The 
rule-of-thumb for setting tolerance is 10x that of the resolution. 


 
 At this point your ArcMap environment should look similar to the following: 
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10. Expand the Search window, select Tools, and type Point File Information.  
 


 Launch the Point File Information tool from the search window. 
 


 Make sure and browse for folders rather than files, then add the 
Exercise5 folder. 
 


 Name the new feature class “PtFileInfo” and place in the 
Terrain_Dataset,  


 
 Set the Input File Format to XYZ, and specify the file suffix as “txt”.  We 


can skip specifying the coordinate system as we know the raw data 
matches our project based on review of the documentation. 


 
 See the example on the next page. 
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11. The PtFileInfo feature class should be added to ArcMap at the top of your Table of 


Contents.  Resymbolize if you prefer and open the attribute table.  What 
information is included?  Right click on the column headed Pt_Spacing and select 
Statistics.  What is the mean point density?  _____.   
 


12. The PtFileInfo polygons are the boundaries of the tiled LiDAR data, i.e. their 
footprint.  Compare with the NCTC boundary.  Does the data meet project 
requirements?  Why may it be useful to work with a polygon footprint of the data 
rather than the point data itself? 


 
13. We are now ready to load the LiDAR data as a multi-point feature class.  Expand 


the Search window, select Tools, and type ASCII 3D to Feature Class.  Launch 
the ASCII 3D to Feature Class tool from the search window and set the following 
parameters as shown on the next page.  Again be sure to browse for folders 
rather than files, and place the feature class, named “BareEarth_Multipoint” in 
the Terrain_Dataset.   


 
 Set the Average Point Spacing to what we previously determined. 


Because the LiDAR data extends outside the NCTC project boundary, we 
will limit the importation using this.  If the project required a smaller AOI 
we could delineate one at this time using the imagery and reference data.   
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 Select the Environments button and set the Processing Extent to Same 
as layer ntc_bnd.  Choose OK and OK. 
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Note:  If the raw data had been in a different coordinate system we could have 
defined it in the ASCII 3D to Feature Class dialog box and the process would have 
projected and transformed it to the project spatial reference in the output feature 
dataset.  Additionally, if the raw data were in different units than our project dataset, 
say feet instead of meters, we could have specified a Z Factor transformation here 
(e.g., .3048). 
 
 
 
 
 
 
 
 
 
 
 
14. The multi-point feature class BareEarth_Multipoint should be added to ArcMap at 


the top of your Table of Contents.  What type(s) of anomalies do you see and 
why? 
 


15. To better evaluate the bare earth muiltipoints, we will calculate the exact point 
density for our project area, and create a raster layer to examine the distribution.   


 
 Launch the Point to Raster tool from the search window and set the 


following parameters as shown below 
 


 Name the output raster “BE_Density” with the .tif file extension in the 
project folder.  Be sure to set the Cell assignment type to COUNT and 
Cellsize = 6.   


 


 


If LiDAR data is received in the LAS data format, use the LAS to 
Multipoint tool.  This tool provides the additional option to specify the 
Class Code (e.g., 1 = Bare Earth) and Return Value (e.g., 1 = first 
return).  Note the bare earth is not always the last return.  Bare earth 
may be first return in areas without vegetation or man-made structures.  
These are ideally the points you want to use to create bare earth DEMs.  
Points returned later than first, though classified as bare earth, may 
introduce undesirable noise to your model. 
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NOTE: Too small a cellsize may result in empty cells and an unnecessarily large 
raster.  Too large a cellsize may inhibit identification of data gaps.  A rule-of-
thumb is to set the cellsize 4x the point spacing, rounded to the nearest whole 
number. 


 
 Examine the attribute table.  What do the Value and Count columns represent?   


 
 
16. To better visualize the distribution of point density, right click on the BE_Density.tif 


layer in the Table of Contents and select Properties, then the Symbology tab.   
Select Purple to Green Diverging, Bright  for the Color Ramp and Display 
NoData as bright red. 
 


 
 
 
17. Turn on the basemap imagery and use the Swipe tool on the Effects toolbar to 


examine the pattern the point density related to land cover.  You may want to 
rearrange or turn off the reference vector data. 
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 How does the point density change in relation to land-cover? 
 


 Is this data suitable for your intended mapping application? 
 


 NOTE: It’s beneficial to check data for accuracy to prevent error 
propagation in future uses.  You can now easily access this data for your 
applications.  Using this data, you can create terrain datasets that define 
surfaces based on vector measurements, digital elevation models (DEMs), 
digital surface models, triangulated irregular networks (TINs), contours, 
viewsheds, and curvatures. 
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SECTION 2 – Build a Terrain (dataset) to Visualize LiDAR Data 
 
In this section, we will build a terrain using the BareEarth_Multipoint feature class, 
ntc_rivers for hydro-flattening, and NCTC boundary as a study area clip layer.   
 


1. While still in ArcMap, expand the ArcCatalog window.  Navigate to and expand 
the NCTC_Terrain.gdb geodatabase.   
 


 Right click on the Terrain_Dataset feature dataset and select Import > 
Feature Class.  Input area_of_interest in the Reference_Data feature 
dataset and output “StudyAreaClip” to the Terrain_Dataset.   
 


The area_of_interest feature class is a bounding box corresponding to the 
ntc_bnd feature class extent used to subset the LiDAR points.  Although the 
points are already clipped, the river polygons extend past the project boundary. 
 


 
 


2. Similarly, import ntc_rivers as “Hydro_Flat” in the Terrain_Dataset. 
 
Prior evaluation of the LiDAR data revealed erroneous points in areas of open 
water.  Knowing the LiDAR acquisition date we were able to look up the river 
stage measured at USGS monitoring sites.   
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3. Open the Hydro_Flat attribute table. 


 
Using stage elevation for segments of the river along with careful delineation of 
the water boundary polygons allows us to hydro flatten our terrain model.  (This 
is a simplified example of hydro flattening.  The stage elevations in the ntc_rivers 
feature class are hypothetical.   Further, it may be inappropriate to assign a 
single elevation to a long reach of river as if it were a flat plane.) 
 


 
 


 
4. Right click on Terrain_Dataset in the ArcCatalog window, select New>Terrain, 


and input the following parameters, choosing  to advance to the next 
window.  The PtFileInfo feature class does not participate in the terrain. 
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5. Change the Height Source and SFType as shown below.  Click Next. 
 
The BareEarth_Multipoint height source is the z-value embedded in each records 
Shape geometries.  The Hydro_Flat height source is explicit in Stage_Elev 
attribute and participates in the terrain as a hard_replace.  A hard_replace 
behaves similar to a breakline and imposes an abrupt change in slope at the 
feature edge.  The StudyAreaClip has no height source.   
 
Clipping does not improve performance of terrains, but is used to exclude areas 
of missing data or limit the display to distinct area of interest.  Subsetting LiDAR 
data for performance considerations should occur when loading into the 
geodatabse. 


 


 
 


6. Select the Z Tolerance.  Click Next.   Z-tolerance pyramid types are used for 
bare earth models as each level offers vertical accuracy approximating that of full 
resolution.  Window-size pyramids is often used for first returns in building a DSM 
as each level partitions data into equal areas. 
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7. Click the Calculate Pyramid Properties button.  Click Next.  For this exercise 
we can just accesp the default pyramid level generation. 
 


 
 
 


8. Review the New Terrain dialog summary, , then choose  
when prompted to build it now.  Add the BE_Terrain to ArcMap by dragging from 
the ArcCatalog window. 
 
Try turning on and off the reference vector data.  Are there topographic 
drainages where the streams are? 
 
Zoom into where the buildings are.  Notice how the resolution of the terrain 
changes with the scale.  How does the terrain behave where the buildings are?  
How could we improve the performance and accuracy of the terrain? 
 
If the terrain looks accurate at full resolution, and retains sufficient resolution at 
scales required for visualization and analysis, we can now derive information 
products, often referred to as “derivatives” from the LiDAR data. 
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EXTRA :  Enable the 3D Analyst Extension and display the 3D Analyst toolbar.  
Select BE_Terrain as the analysis layer.  Notice the toolbar buttons are disabled 
(grayed out).  In the table of contents, right click on BE_Terrain > properties, and 
choose the Analysis tab.  Set 3d Analyst tools to be enabled at a resolution of 1 or 
better.  Zoom in until the tool on the toolbar become enabled.  You know have access to 
the full suite of 3D Analyst toolbar tools. 
 
 
SECTION 3 – Create a DEM and Contour Derivatives 
 
In this section, we will create a Digital Elevation Model (DEM) using the Terrain to 
Raster tool and contours using the Surface Contour tool.  Both tools are available in the 
3D Analyst Extension. 
 


1. Open ArcToolbox from the side window  and select 3D Analyst Tools > 
Conversion > From Terrain, open Terrain to Raster and set the following 
parameters.  Click OK. 
 
With this standard gridded elevation layer you can now derive hillshade and other 
raster information layers using Spatial Analyst Extension, perform hydrologic 
and other analysis, and include them in raster analysis using Map Algebra. 
 


      
 
 
NOTE:  Use the floating point output type to retain precision of elevation in the 
LiDAR data.  Natural Neighbor is a type of zonal weighted interpolation and 
recommended for LiDAR data.  Here we use a cellsize of 3 meters, however, 
most LiDAR data can support DEMs at somewhat finer resolutions.  You cannot 
gain accuracy by using a cellsize that is smaller than the average point spacing.  
The Pyramid Level Resolution of 0 indicates full-resolution.  To generalize a 
surface a lower resolution pyramid level can be used. 
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2. In ArcToolbox, select 3D Analyst Tools > Terrain and TIN Surface, open 
Surface Contour, and set the following parameters.  Click OK. 
 


 
 


 A contour interval of 0.6096 meters is used for 2ft contours 
(2*.3048meters in 1 foot) 


 
 An Index Interval of 3.048 meters is used for index contours every fifth 


contour, or every 10 feet. 
 
NOTE:  Following National Map Accuracy Standards, the rule-of-thumb for 
creating contours from LiDAR data is the contour spacing should be no smaller 
than 2x the vertical accuracy (2) at the 95% confidence interval.  This equates to 
approximately 4x the RMSE of the sample used for the accuracy assessment. 


 
 


3. Zoom into the area around the buildings to better see the detail of 2ft contours 
derived from LiDAR data.  Try symbolizing the index contours as a slightly 
heavier weight than the others. 
 
What else can be done to analyze and visualize the terrain at NCTC? 
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Exercise 6 – Editing with Topology 
  
 
 


Session Objectives:  At the conclusion of this session, you will be able to: 
 


 
 
 Specify editing preferences in ArcMap 


 
 Review basic ArcMap 10 Editing 


 
 Delineate & attribute a simple landcover map 


 
 Create a Topology feature class and add rules 


 
 Validate the Topology 


 
 Fix topological errors in a feature class 
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Material Created By:  Karen Klinger (Dec 2008) 


Revision: Kelly Chadbourne (Nov 2009) 


Revision: Gabriel DeAlessio (May 2010) 


Revision: Gabriel DeAlessio (Nov 2010 – conversion to 7129) 


Revision: Gabriel DeAlessio (May 2011– conversion from 9.3.1 to 10.0) 


Software:  ArcGIS 10 


Directory Path: D:\CSP7200\Exercise6 


GDB:  Ex6.gdb 


Imagery: ntc_ortho_color_2009.sid  


MXDs: Ex6.mxd 
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SECTION 1 – Set the Stage 
 
In this section you will copy the NCTC boundary feature class and paste it into a new 
landcover feature dataset and prepare it for editing. 
 
All data used and created in this exercise will be in the following location:  
D:\CSP7200\Exercise6 
 
 


1. Open ArcCatalog  and navigate to the Ex6.mxd.   
 


2. Click on the Add Data button and browse to \Ex6.gdb\NCTC 
 
Select the NCTC feature class and click Add. 
 


 
 


3. Rename NCTC to NCTC Boundary in the Table of Contents by double 
clicking on the name. 
 


4. Right click on the layer and click on the Symbology tab.  Make the NCTC 
Boundary a hollow polygon with a 2 pt. Black outline. 
 


5. Click on the Add Data button and browse to \Imagery 
 


 Select the ntc_ortho_color_2009.sid and click OK. 
 


 Rename the ortho to 2009 Aerial. 
 


6. Right click on the NCTC Boundary feature dataset and choose Data/ Export 
Data.  This will create a new feature class with a single polygon that we will 
use to delineate our landcover from it. 
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 Save the new feature class as “Landcover” inside the NCTC feature 
dataset.  Be sure to choose “File and Personal Geodatabase Feature 
Classes” inside the browse window. 


 


  
 
 


 Click OK and Yes when prompted to Add to Display. 
 


7. Double click on the symbol to access the symbology menu.  Change your 
symbology to a hollow fill with a red 1 point outline.   


 
8. Next, we will add 2 fields to the new feature class, first Classification and 


Acres. 
 


 Right click on the Landcover feature class and Open Attribute Table. 
 


 Click on Table Options, choose Add Field. 
 


 Name the field Classification, set it to Text and 30 characters. 
 


 Click OK 
 
 


9. Repeat and add an Acres field, making the Field Type a double. 
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SECTION 2 – Set Editing Preferences and begin Editing 
 


1. Load the Editor Toolbar if it is not visible. 
 


2. From the Editor dropdown, choose Snapping, then Options.  
 
3. Ensure that the Snapping tolerance = 10 pixels.  Click OK. 


 


 
 
 


 
4. Again, drop down the Editor and now choose Options.  


 
5. Set your Sticky Move Tolerance to 30.  This protects against accidentally 


moving features. 
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6. On the Table of Contents, choose the Selection tab. 
 


 
 


 Be sure only the Landcover is checked making it the only selectable 
layer.  You can Toggle the Layers Off or right click Landcover and 
choose “MakeThis the Only Selectable Layer”.  This avoids accidentally 
selecting the wrong piece of data. 


 
9. Return to the Display tab. 


 
 


7. On the Editor bar, drop down Editor and choose Start Editing. You will various 
notice buttons become active, and a new “Create Features” box opens. 
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8. Uncheck the NCTC Boundary in the Table of Contents.  Notice that it is 
removed from the Create Features window when turned off.  This is another 
protection against editing the wrong feature class. 
 


9. Use the Edit Tool to select the Landcover polygon.  
 


 
 


10. Select the polygon.  Activate the Cut Polygon tool.   
 


 
 


11. Left click to Start the delineation outside the selected polygon, clicking on your 
delineation through the feature and double clicking outside again to complete. 
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12. Repeat steps 9 & 10 and create polygons for 4 general landcover classifications 
(Developed, Forest, Shrub, Field).   


 
13. Click the Attributes button on the Editor toolbar.  This will toggle the Create 


Features box to the Attributes box. 
 


 
 


 
 


14. Select a feature, click on the Classification field and add the description.  
Repeat for all the features. 


 
 


Tip: For ease of display, you can alter the attribute field shown in the Attribute 
box.  Go to Layer Properties, Display Tab.  Change the Field to Classification. 
 


 
 


 
15. Stop Editing and Save Edits. 
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MANDATORY BONUS!  Calculating Acres 
 
Whenever edits are made, you’re shape_area field in a Feature class will automatically 
update.  Units of area are in the projection units of the Feature Class.  However, if you 
want to report units other than the default, you need to recalculate them.  
 


 Open the attribute table by right clicking on your Feature Class. 
 


 Find the Acreage field and right click on it, choose Calculate 
Geometery 


 
 Make sure Area and the correct projection are selected and select Acres 


US (ac).   
 


 Click OK. 
 


 
 
 
 
 


 


     PLEASE STOP HERE BEFORE MOVING TO THE NEXT SECTION   
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SECTION 3 - Establish Topology Rules  
 
The Landcover layer you just built was created by on-screen digitizing, with 2009 aerial 
imagery and the NCTC boundary layer as reference.  No topology rules were taken into 
account, and as a result, the layer has no topological integrity.  In layman’s terms; the 
polygons may or may not border each other correctly.   
 
In this part of the exercise, we will use a pre-delineated landcover, one that has 
common errors that sometimes occur when editing.  Some polygons overlap their 
neighbors, while others don’t come close enough and leave gaps.  We’re going to apply 
the following topological rules (i.e., relationships) in the geodatabase to clean-up the 
mess: 
 
Rule 1 A polygon cannot exist in the space as another polygon or overlap;  
 
Rule 2 All polygon boundaries are contiguous and there are no gaps between 


polygons; and  
 
Rule 3 Landcover feature class must cover NCTC’s feature class boundary. 
 
 


1. Open ArcCatalog inside ArcMap .  Browse to \Ex6.gdb 
 


2. Right click on the NCTC  feature dataset, select New and choose  Topology. 
 


3. A New Topology dialog appears.  Read the overview information.  Click 


. 
 


4. Name the new topology Landcover_Topology.  Accept the default tolerances.  


Click  
 


5. Select NCTC and LC_Premade to participate in the topology.  Click . 
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6. Enter the number of ranks to be 2.  Then, change the rank values as shown 
below.   
 


 
 
 


What does this ranking mean?  Feature classes of a lower rank will be 
snapped to feature classes of a higher rank (the HIGHEST rank = 1).  So, in 
this example, the habitat layer will be adjusted to the boundary layer.  The 
boundary is ranked the highest because we want to minimize any adjustment of 
this feature.   
 


Click . 
 


7. Use the  button to add the following 3 rules: 
 


LC_Premade - Must Not Overlap 
LC_Premade - Must Not Have Gaps 
LC_Premade - Must Cover Each Other - NCTC 


 
8. Click Next when finished adding the topology rules.  A summary appears in the 


New Topology dialog.  Click Finish.               
 


9. Choose NO when asked to validate the topology.   We will validate the topology 
and fix any errors using ArcMap in the next section.    
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Why did we select these topology rules? 
 


Must Not Overlap – Requires that the interior of polygons in the feature class not 
overlap. The polygons can share edges or vertices. This rule is used when an area 
cannot belong to two or more polygons. It is useful for modeling administrative 
boundaries, such as ZIP Codes or voting districts, and mutually exclusive area 
classifications, such as land cover or landform type. 
 
Must not have gaps – This rule requires that there are no voids within a single polygon 
or between adjacent polygons. All polygons must form a continuous surface. An error 
will always exist on the perimeter of the surface. You can either ignore this error or mark 
it as an exception. Use this rule on data that must completely cover an area. For 
example, soil polygons cannot include gaps or form voids—they must cover an entire 
area. 
 
Must Cover Each Other – Requires that the polygons of one feature class must share 
all of their area with the polygons of another feature class. Polygons may share edges 
or vertices. Any area defined in either feature class that is not shared with the other is 
an error. This rule is used when two systems of classification are used for the same 
geographic area, and any given point defined in one system must also be defined in the 
other. One such case occurs with nested hierarchical datasets, such as census blocks 
and block groups or small watersheds and large drainage basins. The rule can also be 
applied to nonhierarchically related polygon feature classes, such as soil type and slope 
class. 
 
For complete listing of rules and fixes, open the ArcGIS help and look up topology rules. 
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  SECTION 4 – Validate Topology & Must Cover Each Other Errors 
 


 
1. Remove the NCTC Boundary and Landcover from the map by right clicking and 


choosing “Remove”.  (Only the imagery should remain.) 
 


2. Add the topology to the map.  Drag the Landcover_Topology from ArcCatalog 
to your Table of Contents. 
 
When prompted, click Yes to add all associated feature classes.  Adjust the 
symbology as you see fit. 


 


3. Zoom to Full Extent  if the entire boundary is not visible.  It’s time to validate 
to see to see if and where errors exist within the feature classes.  
  


4. Pin ArcCatalog closed in ArcMap. 
 


5. Load the Topology Toolbar.  Click Customize/Toolbars/Topology.    
 


6. Start Editing. 
 


7. Click the Validate Topology in Current Extent   button.   
 


  
 


Tip: There are additional buttons to Verify Topology for a Specified Area or 
Validate Entire Topology that may save time when working with a large dataset. 
 


8. Click Yes when asked if you are really sure you want to validate the full extent. 
Yikes, look at all that red!    


 


9. Click the Error Inspector   tool.  This tool allows you to manage and interact 
with the topology errors on your map. You can search for violations of specific 
topology rules or for exceptions (errors that you mark as acceptable). You can 
also choose whether to inspect the currently visible extent or the entire 
topology. 


 


  
 


10. Click the  button.  You should find 21 errors total. 
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11. Click on Down Arrow and Select Must Cover Each Other.  Click  
 


12. Click on the first error in the Error Inspector.  Notice how the identified error 
turns black on the map.   
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13. Close inspection reveals that the habitat management unit boundary lies 
outside the NCTC Boundary. 


 
 


To fix errors identified by the Must Be Covered By Feature Class Of rule we 
two options: 


 
Subtract: removes the overlapping portion of each feature that is causing the 
error so the boundary of each feature from both feature classes in the same.  


 
Create Feature:  creates a new polygon feature out of the portion of the 
overlap from the existing polygon so the boundary of each feature from both 
feature classes is the same.  


 
14. With this error selected, Right click on the selected line inside the dialog and 


select Subtract.  This will remove this area completely from the LC_Premade 
layer (reshaping the layer’s boundary).  Do not use Create Feature as this fix 
will modify the NCTC Boundary, which we know is correct and don’t want to 
change. 
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15. Another way to correct topology is to use the Fix Topology Error Tool .  
Activate the tool on the toolbar by left clicking on it. 


 
 With the tool active, select the error to in the northeast. 


 


 
 
 


16. Looking closely will reveal that there is a gap in the landcover between the 
NCTC Boundary and the existing landcover polygons.  To correct, we need to 
right click and select Create Feature to add in a polygon. 
 


17. Once the feature is added, open the Attribute tool.  You will notice that it lacks 
any attribute data. You can code it individually or choose to merge it to an 
adjacent feature.   
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18. Select both the new polygon and the Forest polygon to the south.  Then in the 
Editor Menu, select Merge. 
 


 
 


 Be sure to select the feature with attributes to Merge to rather than the 
new one to retain those attributes! 


 


19. Now let’s Validate Entire Topology   again to make sure we fixed the 
problem.   


 
20. Notice this error is gone now.  Leave the remaining errors for now, we’ll fix them 


later. 
 


TIP:  To control the attribute tags displayed with tools like Merge, use the Layer 
Properties/Fields tab and define the Primary Display Field. 
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SECTION 5 – Validate Topology (Must Not Have Gaps) 
 
In this section we’ll examine the MUST NOT HAVE GAPS errors.  This is one of the few 
rules that will ALWAYS generate an error.  This is because you will always have an 
‘end’ to your polygons extents, and therefore a ‘gap’ where they do not touch another.  
We will start by marking this error as an exception 
 
 


Must Not Have Gaps 


This rule requires that there are no voids within a single polygon or 
between adjacent polygons. All polygons must form a continuous surface. 
An error will always exist on the perimeter of the surface. You can 
either ignore this error or mark it as an exception. Use this rule on data 
that must completely cover an area. For example, soil polygons cannot 
include gaps or form voids—they must cover an entire area. 


 


1. Click on the Fix Topology Error Tool . 
 


2. Click on the boundary so that it has a black outline.  
 


 
 


3. Click the Error Inspector   button.  Notice there is only one error shown. 
 
4. Since this one error will always show up when we inspect, let’s make it an 


exception so it won’t appear again. That way, only the errors we are concerned 
with will be displayed in the Error Inspector dialog. Right click on the error and 
choose Mark as Exception. 


 


     PLEASE STOP HERE BEFORE MOVING TO THE NEXT SECTION   
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Tip: If you need to go back to the error you marked as an exception, in the Error 
Inspector check Exceptions and click Search Now. Notice if you Right click on the 
Exception you can choose Mark as Error. 


 
 


5. Validate the Entire Topology again to make sure we fixed the problem. 
 
6. Close the Error Inspector dialog. 


 
 


7. Let’s look at actual errors now.  On the Main Menu, click on Bookmarks/Water 
Treatment to zoom into water treatment facility located in the northwest section 
of the campus.  (Note: the pink fill color was turned off using the symbology.) 
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8. Click the Error Inspector   button.  
 


9. Click .  Select the “Must Not Have Gaps” error to identify the 
error on the map (i.e., polygon changes to black). 


 
To fix errors identified by the Must Not Have Gaps rule we have 1 option within the 
error inspector: 


 
Create Feature: creates a new polygon feature from the line error shapes that 
form a gap. This fix can be applied to one or more selected Must Not Have 
Gaps errors. If you select two or more errors and use the Create Feature fix, 
the result will be one polygon feature per gap.  


 
Because we do not want gaps within LC_Premade feature class, we will 
choose to Create Feature.  You can do this within the Error Inspector (see 
previous section) or by using the Fix Topology Error Tool on the map.  This 
section will focus on the latter option. 


 


10.  Close the Error Inspector.  Click on the Fix Topology Error Tool .  
 


11. Click on the topology polyline error so that it is outlined in black.  Right click and 
select Show Rule Description – This polygon breaks the rule that a void 
cannot exist between areas in the same layer. 
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12. To fix this error – Right click and select Create Feature, which will create a new 
polygon feature within LC_Premade (getting rid of the gap). 
 


 
 


13. Open the Attribute table and Attribute the new polygon to Developed. 
 


14. Validate the Entire Topology again to make sure we have fixed the problem. 
 
 
TIP:  After any polygon editing session; including the subtracting and creating and 
merging we just did, remember your Acreages are no longer accurate!  ALWAYS 
recalculate your Acreages after editing shapes. 
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SECTION 6 – Validate Topology (Must Not Have Overlap) 
 
In this section, we will zoom-in to an area where polygons are overlapping.  Since a 
landcover can only have 1 attribute per location, these are errors that need to be 
corrected.  Overlapping polygons also lead to double counting of acreages. 
 


1. Zoom into NCTC extent. 
 


2. Click the Error Inspector   button.   Click .    
 
3. Select the “Must Not Have Overlap” error to identify the error on the map.  See 


the screen shot below. 
 


 
 
 


To fix errors identified by the Must Not Have Overlap rule we have 3 options 
within the error inspector: 


 
Subtract: removes the overlapping portion from each feature and leaves a gap 
or void in its place. This fix can be applied to one or more selected Must Be 
Covered By Feature Class Of errors. 


 
Merge: adds the portion of overlap from one feature and subtracts it from the 
others that are violating the rule. You need to pick the feature that receives the 
portion of overlap in the Merge dialog box that pops up. This fix can be applied 
to one Must Not Overlap error only. 
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Create Feature: creates a new polygon feature out of the error shape and 
removes the portion of overlap from each of the features. The fix can be applied 
to one or more selected Must Be Covered By Feature Class Of errors. 


 
 


4. Open the Fix Topology Error Tool .   
 


5. Select the error highlighted below. 


 
 


6. Right click on the topology shown below and select Merge.    
 
Do Not use Create Feature (which will make new polygons) or Subtract (which 
will create slivers in the LC_Premade feature class). 


 
7. Based on the underlying landcover, select the second feature on the list and 


click OK. 
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8. Validate the Entire Topology again to make sure we fixed the problem. 
 


9. Click on the Fix Topology Error Tool .  
 
10. Select the large overlapping error. This polygon was delineated on top of an 


existing one.  We need to make sure only 1 polygon exists. 
 


 
 
 
11. Right click and choose Create Feature.  This forces 2 simultaneous actions, it 


subtracts the shape from the underlying polygon, and it creates a new feature in 
the same location. 
 


12. Identify on the new feature.  You will notice the attribute has been lost since the 
Create Feature removes the existing and replaces it with a new polygon.  You 
can attribute the new polygon to Forest. 


 
13. Validate the Entire Topology again to make sure we fixed the problem. 


 
14. Save your edits.  


 
15. Using the skills learned in this exercise; continue fixing any remaining 


topological errors if time permits. 
 


Remember to update acreages at the end of editing. 
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Exercise 7 - Using Model Builder 
  
 
 


Session Objectives:  At the conclusion of this session, you will be able to: 
 


 
 
 Use ModelBuilder to create a workflow model  
 
 Create tools from models  


 
 Document models in ModelBuilder and ArcCatalog 


 
 Share models with other users 
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Exercise developed by:  Sean Fields (Dec 2006) 


Modified: Jacob Lewis (Jan 2008), Gabriel DeAlessio (Jan 2009), Chris Castiglione 


(Nov 2010), Sean Fields (Nov 2011) 


Software Version: ArcGIS 10.0, SP3 


Directory Path: D:\CSP7200\Exercise7 


GDB:  cro.mdb, FWSCadastral.mdb 
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ModelBuilder Overview 
 
The geoprocessing tools in ArcGIS make it easy to process spatial data to model 
aspects of the real world. However, when there are many steps involved in your 
geoprocessing work flow, it can be difficult to keep track of the assumptions, tools, 
datasets, and other parameter values you have used.  
 
One of the easiest ways to author and automate your work flow and keep track of your 
geoprocessing tasks is to create a model. ModelBuilder is an application you use to 
create, edit, and manage models. Models are workflows that string together sequences 
of geoprocessing tools, feeding the output of one tool into another tool as input. 
ModelBuilder can also be thought of as a visual programming language for building 
workflows.  
 
Managing processes and their supporting data can be difficult without the aid of a 
model. A sophisticated model contains a number of interrelated processes. At any time, 
you may add new processes, delete existing processes, or change the relationships 
between processes. You may also change assumptions or parameter values, for 
example, replace old datasets with newer ones, or consider alternative scenarios in 
which input factors are prioritized differently. Building a model helps you manage this 
complexity in a number of ways:  


 It makes processes and the relationships between processes explicit, and the 
model you create is dynamically updated whenever a change is made. 


 It lets you set values for the parameters of each tool, and it records this 
information, making the model output easily reproducible.  


 It lets you edit the structure of the model by adding and deleting processes or 
changing the relationships between the processes.  


 It lets you edit the parameter values defined for tools to experiment with 
alternative outcomes.  


The ModelBuilder window is the interface you use to create models in ArcGIS. A 
ModelBuilder window is displayed immediately when you create a new model.  The 
window consists of a display window in which you build a diagram of your model, a Main 
menu, and a toolbar that you can use to interact with elements in your model diagram. 
You can run a model from within the ModelBuilder window or from its dialog box. 


To build a model, you can drag tools from toolboxes in the ArcToolbox window or the 
ArcCatalog tree and data from the ArcCatalog tree or the table of contents of any other 
ArcGIS Desktop application, such as ArcMap. Alternatively, use the Add Data and Tools 
button in the ModelBuilder window to add tools and data, which places their 
representative elements on the model diagram. When you fill in necessary parameter 
values for each tool and connect processes, your model will become ready to run.  
Any parameter within the model can be set as a variable that can be shared between 
processes. This means you don't have to make updates to every tool that uses a 
particular parameter value; you can just update the value in one dialog box. 
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ModelBuilder Interface 
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SECTION 1 – Build a Model in ModelBuilder 
 
In this section you will build a basic model using ModelBuilder that calculates wetland 
acres within the Crab Orchard National Wildlife Refuge boundary.  
 
All data are located in the D:\CSP7200\Exercise7 folder. 
 
TASK 1 – Set the Stage 
 


1. Launch ArcMap and open a new empty map.  Change the default geodatabase 
to CRO.gdb. 


 
 


2. Add    the Wetland_Data Feature Dataset from the CRO.gdb, and also 
add the FWSApp_CRO.lyr file.   
 


3. Open ArcToolbox .  Right-click in an empty space in ArcToolbox and select 
Add Toolbox. 


 
 


4. Click on the New Toolbox button  in the upper right corner of the Add 
Toolbox dialog.   Rename the toolbox to NCTC_Tools.tbx.  Select the 
NCTC_Tools.tbx then click Open. 


 
5. Save the current ArcToolbox setting as default by right-clicking in an empty 


space in the ArcToolbox and select Save Settings > To Default. 
 


6. Right-click on NCTC Tools and select New > Model. The ModelBuilder window 
will open automatically.  


 
7. Take a few minutes to familiarize yourself with the new tools by dragging your 


mouse over the button to identify each one. 
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TASK 2 – Build the Model 
 


The NWI data for the refuge exists as seven different feature classes representing the 
seven NWI quads.  You need to combine them into one feature class.  The Append tool 
will do this for you, but first you need to create an empty feature class that will store all 
of the wetland data. 
 


1. Drag the Create Feature Class tool into the ModelBuilder window.  This tool is 
located in the Data Management Tools > Feature Class toolset. Note that the 
tool elements are hollow; not colored-in.  This indicates that the tool is missing 
one or more necessary parameters. 


 


 
 


2. Double-click on the Create Feature Class tool element and populate the fields 
as shown below.  
  
 Name the new feature 


class cro_nwi_all.  
 
 Select carbondale_nwi 


from the drop-down list.  
Click OK. 
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3. Your model is now color shaded and ready to run.  Organize your model 
components by resizing and dragging them with your mouse or simply clicking 


the Auto Layout Tool . 
 


 
 
 


4. Drag the Append tool into your model from the Data Management Tools > 
General Toolset.  This tool will be used to combine all of the NWI layers into the 
cro_nwi_all feature class from the previous step. 
 


 
 
 


5. Right-click the Append tool and select Make Variable > From Parameter > 
Input Datasets.  The Input Datasets element will appear.   


 
6. Double-click the Input Datasets element to open a dialog.   


 
 Select all seven NWI layers from the Input Dataset drop-down, 


click OK.  The Input Datasets element turns light blue indicating that it is an 
Input Value Variable. 
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7. To connect the elements together, double-click the Append tool element. 
 


 Select cro_nwi_all from the Target Dataset drop-down list (you may need to 
scroll down to see the Target Dataset field).   Click OK.   
 


 
 


 Your model should look like this after clicking Auto Layout    and then 


clicking Full Extent . 
 


 
 
 


STOP HERE!
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8. Next, drag the Clip tool into your model to clip the larger NWI layer to the 
refuge boundary.  The tool is located in the Analysis Tools > Extract Toolset.   


 
9. Drag the FWSApp_CRO layer from the ArcMap Table of Contents to the 


ModelBuilder window.   
 


10. Using the Add Connection  button, first connect the cro_nwi_all(2) output 
to the Clip tool element.  Choose Input Features on the parameter options 
popup dialog. 


                      
 
 


11. Next, connect the FWSApp_CRO to the Clip tool.  Choose Clip Features after 
the connection is made and the options popup dialog appears. The end of your 


model should look like the image below after clicking the Auto Layout   


button, and using the Zoom In Tool  to zoom into the end portion of the 
model. 
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12. Click the Select  tool on the ModelBuilder toolbar.  Double-click the Clip tool 
element and populate the fields as shown below.   
 


 Rename the Output Feature Class cro_nwi.  Click OK. 
 


        
 
 


14. Next, add the Add Field tool, located in the Data Management Tools 
toolbox > Fields toolset, to the ModelBuilder window. 


 


15. Connect  the Add Field tool to the cro_nwi clip output.  Choose Input 
Table in the options popup dialog. 
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16. Double-click the Add Field tool element and make sure that the Field Name 
and Field Type fields are as shown below.  Click OK. 
 


 
 
 
 


14. Add the Calculate Field tool from the Data Management Tools  > Fields 
Toolset and connect the tool to the newly generated cro_nwi (2) element.  
Choose Input Table from the parameter options popup dialog. 


 


 
 


15. Double-click on the Calculate Field tool to specify the tool parameters.  Set 
the Field Name to acres and the Expression to [Shape_Area] * 0.0002471.  
Click OK.  Note: this is the conversion factor from square meters to acres. 
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16. Your final model should now look like the one below.   
 


 
 
 


TASK 3 – Run the Model  
 
1. To calculate wetland acres, right-click on the final dataset Cro_nwi (3) and 


select Add to Display.    
 
2. From the Model menu, choose Run.  The model will run and Cro_nwi (3) will 


be added to your TOC when complete.   
 


3. From the Model menu, choose Save. 
 


4. Open the cro_nwi attribute table in your Table of Contents.  What is the total 
wetland acreage for Crab Orchard NWR ___________? 


 
 
 
 
 
 


STOP HERE!
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SECTION 2 – Create a Tool from the Model and Document the Tool 
 
In this section, you will create a tool in ArcToolbox from the NWI model by exposing the 
model parameters.  This will allow use of the model at any National Wildlife Refuge that 
has the required boundary and wetland datasets.  You will also create documentation 
for the model. 
 


1. If not already open, open the Model you just created by right-clicking its icon in 
ArcToolbox and selecting Edit… 
 


2. You will rename some of the model elements so other users can easily 
understand the model.  Rename the circled model elements in the following 
figure as described below.  To do so, right-click each element and select 
Rename.  Stretch the graphics so all of the names are visible. 


 
 


 
 
 
 Create Feature Class Tool data variables 
  a. Rename Wetland_Data to Output Location  
  b. Rename carbondale_nwi to NWI Template Feature Class 
 
 Append Tool value variable 


c. Rename Input Dataset to NWI Input Features 
 


 Clip Tool data variable 
d. Rename FWSApp_CRO to Refuge Boundary 
e. Rename cro_nwi(3) to Final NWI Feature Class 


 
 


a


b


c


d
e
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At this point, if you were to double-click 
on the model’s icon in ArcToolbox, you 
would see the dialog to the right. 
 
This is not an error.  It just means no 
model parameters have been set.  You 
will expose the model’s parameters in 
the next step. 
 
 


3. Right-click on all 5 of the model components you renamed and select Model 
Parameter to expose each parameter.  A ‘P’ will be displayed above each model 
parameter as shown below. This allows for user input on the Model tool’s dialog.   


 


 
                                              
   
 


4. Now you will create attached labels for the tools in the model.  To do this, right-
click each tool element and select Create Label from the context menu.  Label 
the tools as specified below: 
 
Tool    Label 
Create Feature Class Creates a new empty feature class 
Append   Appends specified NWI to Refuge NWI Output 
Clip    Clips Refuge NWI Output to the refuge boundary 
Add Field   Adds the acres field 
Calculate Field  Calculates acres from Shape_Area field 
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5. Position the new labels as appropriate.  Your final model should look like the 
one below: 


 


 
 


 
6. From the Model Menu, choose Export >To Graphic... and export the model 


graphic to Exercise7 and name the file model_graphic.jpg.  We will add this 
file to the Model Documentation later.  Click OK to continue. 


 
7. Rename the model to give it a more descriptive name.  From the Model Menu, 


choose Model Properties... and modify the fields as shown below.  Do not use 
underscores or spaces in the Name field.   
 


 Make sure to click the box to sore relative path names.  Click OK to continue. 
 


 
 


8. Save the model and Close the ModelBuilder window. 
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9. In the ArcMap Menu bar, select Geoprocessing > Geoprocessing Options.   
 


 At the top of the Geoprocessing Options dialog in the General section, check 
the Overwrite the outputs of the preprocessing operations. 
 


 At the bottom under Display/Temporary Data section, check the Add results 
of geoprocessing operations to the display.  This will automatically add 
the final data to the display when the model is run as a tool. 


 
10. In ArcToolbox, double-click the Calculate NWR Wetland Acreage model icon.  


This opens the model’s dialog.  Notice that the exposed model parameters are 
now available for user input.  Click Cancel to close the model too 
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11. You now need to document and describe the model to be able to share with 
other users.  Model and tool documentation editing can only be completed in 
ArcCatalog.   


 
 Open ArcCatalog and navigate to the Exercise7 folder in the catalog 


tree.  Select your model in the catalog tree and then click on the 
Description tab to view the models description. 


 


 
 


 


12. Click the Edit button  on the Description panel.  This opens the Item 
Description for editing.   
 


 Scroll down below the Title section and Click the Update button to add the 
model graphic to the Item Description.  Navigate to the 
model_graphic.jpg image you exported previously.  


 







GIS Project Design I: Data Development and Management                                                                  2011 
U.S. Fish and Wildlife Service                              National Conservation Training Center 
 


Model Builder                                                                                      18 


 
 


13. Next, scroll down to the Summary section and add a statement that describes 
the model you created similar to the one shown below.  


 


                        
 


 


14. Scroll down to the Syntax section and click on the  button to expand the 
Refuge Boundary section.  Add a statement in the Dialog Explanation section 
that describes the Refuge Boundary model parameter similar to the one below.   
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15. Repeat step 14 for each of the model parameters.  A single sentence for each 
will be sufficient.  Finally, add your name to the Credits section.  Click Save 
and review the Item Description. 
 


16. Double-click on your model in ArcToolbox or the Catalog Tree to open the 
model tool dialog.  Note the descriptions and titles of the parameters in the 
dialog and the help section on the right side of the dialog (Click the Show Help 


 button if the help is not displayed).   
 


17. Notice that the parameters in the tool dialog box are prepopulated with values 
you entered when the model was first created.  If you open the tool in ArcMap 
and there is not a layer that matches those prepopulated values, the dialog box 
will display an error (a red X) because the layers do not exist in that ArcMap 
document. While this is not an issue—you can always select another layer or 
browse to another dataset—you can avoid the nuisance of the error message 
by clearing out the variables in the model. The model will no longer run in 
ModelBuilder, but it will run using its tool dialog box. 


 
18. Run the model as a tool. 
 
 
Congratulations!  You have completed the Calculate NWR Wetland Acreage model 
and can now distribute the model by simply sharing the entire NCTC Tools toolbox 
that stores the model.   
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Challenge Topic 
 
If you finish the exercise and want to further explore Model Builder, here are some 
challenges to tackle: 
 
Although the NWI quads were appended together, the cut lines remain are quad breaks.  
In your model, incorporate the Dissolve tool to fix this. 
 
Next, you now need to conduct some further analysis and generate some summary 
statistics.   Modify the existing model so it will generate the following information 
product: 
 
A table that lists the total acreages for all of the wetland types (WETLAND_TY) found at 
the Crab Orchard NWR. 
 
How many different wetland types are within Crab Orchard NWR?_____ 
 
How many freshwater emergent wetland acres are within Crab Orchard NWR?_______ 
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Exercise 8 – Suitability Analysis   
  
 
 
Session Objectives:  At the conclusion of this session, you will be able to: 
 
 
 Set Spatial Analyst options 
 
 Perform surface analysis 


 
 Reclassify grids 


 
 Convert feature class to grid 
 
 Add a new tool and generate a multiple ring buffer 


 
 Determine proximity using straight line distance 


 
 Use weighted overlay tool to conduct suitability analysis 
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Material Created By:  Todd Sutherland (Feb 2009) 
 
Modified: Christopher Bryant (Nov. 2011) 
 
Software Version:  ArcGIS 10, SP3 
 
Directory Path: D:\CSP7200\Exercise8 
 
Shapefiles:  
 
Tables:  distance_reclass 
 
GDB:  landfill.gdb 
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The GIS Objective 
  
Conduct a suitability analysis to help identify possible sites for a new landfill in Gallatin 
County, Montana.  You will use different methods to reclassify each layer, but all 
methods will produce the same effect: rating the values for each grid on a scale of 1-5, 
with the value of 5 being most suitable for establishing a new landfill and the value of 1 
being the least suitable. 
 
Layers to be included in analysis are: 
 
County Boundary (used for setting analysis mask only) 
Elevation (high slopes, less suitable) 
Streams (proximity to streams, less suitable) 
Landfills (proximity to existing landfills, less suitable) 
Drainage Patterns (this layer already classified, well drained sites less suitable) 
Extra: Land Cover (suitability of cover classes to be determined by student) 
 
All layers are located in the D:\CSP7200\Exercise8 folder within the Landfill 
geodatabase. 
 
 
TASK 1 - Setting Options and Preparing Layers For Analysis   
 
ELEVATION – Create a slope layer and reclassify  
 


1. Open a new empty ArcMap session and make sure to change the default GDB to 
landfill.gdb 


 
 


2.  Add the county_bnd and elevation layers to ArcMap.   
  
3. Open the 3D Analyst toolbox and navigate to Raster Surface > Slope tool. 


 
 Specify the input raster as elevation.  Specify your output storage to the 


exercise8 folder. 
 


 Save the raster as Slope1 and change the Output Measurement to 
Percent_Rise. 


 
 Click on the Environments button in the Slope Tool dialog, and navigate 


to Raster Analysis. Set the Cell Size to “As Specified Below” and enter in 
1000.   


 
 Set the mask to the county_bnd layer then click OK.     
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NOTE: The mask identifies those cells within the analysis extent that will be 
considered when performing our raster analysis.   


 
Be cautious when specifying a cell size finer than the input raster or raster.  No new 
data is created; cells are interpolated using nearest-neighbor resampling. The result 
is as precise as the coarsest input. 


 
4. We now need to reclassify the percentage of slope values to reflect suitability.    


Choose 3D Analyst > Raster Reclass > Reclassify.  Select the input raster as 
Slope1 and click Classify.   
 


 Change the method to Equal Interval with 5 classes.  Click OK. 
 


 Specify the following old values and new values.  You must have a space 
between the number and hyphen!   


 
 Name the new raster file SLOPE and click OK. 
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STREAMS – Add a new tool, generate buffers, create raster and reclassify 
 


1. Remove the Elevation and Slope1 layers in the table of contents as they are 
no longer needed.   
 


2. Add the streams layer to your map. 
 
3. We need to add a new tool to perform a multiple ring buffer.   From the Tools 


menu, choose Customize > Customize Mode. 
 


 Click on the Commands tab.  Type buffer in the Show Commands 
containing section.   
 


 Click on Tools in the categories section.    Drag the Buffer Wizard 
command to the Tools Toolbar.  You have just added a new command 
which will allow us to create a multiple ring buffer. 


 


 
 


4. Click on the Buffer Wizard Tool .  Ensure the streams layer is selected 
as the layer you want to buffer.  Click Next.    


 
 Assign 4 buffer rings at a distance of 1 kilometer each and click Next. 


 


 
 


 Click Yes to dissolve the barriers. 
 


 Save the new layer as a feature class named buffer_of_streams and 
store in the landfill geodatabase.  Click Finish. 
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5. Next, we need to convert this polygon to a raster.  In the ArcToolbox, navigate 
to Conversion Tools > To Raster > Feature to Raster.    


 
 Ensure input is buffer_of_streams. 


 
 Specify ToBufDist as the field, with a cell size of 1000.   


 
 Assign the name stream_buff.   Click OK. 


 


 
  


6. Next, reclassify the NO DATA values to be equal to 5 in the stream_buff 
layer.  These are the areas farthest away from streams.  Choose 3D Analyst 
> Raster Reclass > Reclassify.   


 
 Change the Classify method to Equal Interval with 4 Classes.   


 
 Change the No Data value to a 5 in the New Values column.   


 
 Name the file STREAMBUFF and save in the Landfill.gdb. Click OK.   
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LANDFILLS - Query, generate proximity, reclassify 
 
The location of a new landfill will be affected by where operating landfills currently 
exist.  You will calculate for each cell, the Euclidian distance from the nearest open 
landfill.     
 
1. Add the Landfills feature class to your map.    
 
2. Use Select By Attributes and query for STATUS = O.   This selects all landfills 


that are currently in operation (open). 
 


3. From the Spatial Analysis toolbox, choose Distance > Euclidean Distance.  Set 
the input feature source to landfills.   
 


 Save as File Geodatabase Raster in the landfill geodatabase using the 
name landfill_ED.   
 


 Set the cell size to 1000   Click OK. 
 


 
 


 
4. Reclassify the data again, but this time let’s reclassify this grid using a 


classification that has been saved.  Choose 3D Analyst > Raster Reclass > 
Reclassify. 
 


 Click the Load button.   Navigate to the tables folder and choose the 
distance_reclass table.  
 


 Save as LF_DISTANCE in the landfill GDB.  Click OK when done. 
 


5. Remove the landfill and landfill_ED layers to reduce clutter in your Table of 
Contents. 
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TASK 2 – Conduct a Weighted Overlay Analysis 
 


1. Add the soildrainage raster layer to your map. 
 
Soils are an important characteristic for landfill sites because they often indicate 
wetlands, rock depth and drainage.  The soil drainage has already been 
reclassified for you by the county geologist.   Landfills are prohibited from 
occurring on water or rock thus those areas were reclassified as NoData. 
 


2. Locate the Weighted Overlay Tool in the ArcToolbox and open the tool. 
 
3. Change the Evaluation Scale to 1 to 5 by 1  
 
4. Add the 4 layers to be considered in this analysis one at a time into the tool. 


 
5. Click Set Equal Influence.  This assigns equal weights to all input layers. 


 
6. Use the name Weight1 and store in the landfill geodatabase.  Click OK to 


generate a new grid. 
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7. Which area of the county has the most suitable landfill sites based on your 
analysis? 
________________________________________________________________
________________________________________________________________
________________________________________________________________  


 
 
CHALLENGE TOPIC 
 
Conduct another analysis but this time apply different weights to the layers using your 
own personal preference as to which ones should have more influence on choosing a 
landfill site.    Compare with your first analysis.    


 
Be prepared to discuss how the two results differ and why? 
 
Make a final map showing your result  
 
CHALLENGE TOPIC 2 
 
Conduct another analysis by including the landcover layer as one of your inputs.  Use 
the following information and create your own classification scheme based on the land 
type, abundance of type, or value of the land type. 
 


LANDCOVER - Reclassify 
 


1. Add the coverclass layer to your map. 
 
2. Right click the layer and select Open Attribute Table.  Sort the Count field 


descending.    Notice that Coniferous Forest makes up the most land cover 
in the county. 


 
3. Use this table and develop your own classification scheme for suitability 


ranking.  Some things to consider are the cultural or financial value of the 
existing land type, the expense of altering the land type, and the relative 
abundance or scarcity of the land type (the count field).    Write your 
classification scheme you developed for suitability.  You do not need to use 
all 5 values.  For example, you can have only ones (least suitable), fives 
(most suitable) and NO DATA.   
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4. Use the Reclassify tool to reclass the land cover using the values 1 to 5 with 
1 being least suitable and 5 most suitable. 


 
5. Make the new layer permanent and assign the name COVERTYPE and save 


in the landfill geodatabase. 
 


6. Remove the coverclass layer.  Rename the permanent layer in the table of 
contents to COVERTYPE. 


 
7. Use the Weighted Overlay Tool from Step 2 above to create a new 


Suitability map by adding the COVERTYPE layer as one of the inputs. 
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AGENDA 
 
 


Day 1 – GIS Planning, Data Acquisition and Data Management 


Discussion 8:00-9:00 Course Overview and Project Ideas  


Discussion 9:00-9:30 GIS Planning  


 
9:30-9:45 Break 


Exercise 1 9:45-12:00 Establishing Spatial Reference  


 
12:00-1:00 Lunch 


Discussion 1:00-1:30 Acquiring Spatial Data  


Exercise 2 1:30-2:30 Geodatabase Design  


 
2:30-2:45 Break 


Exercise 2 2:45-4:30 Geodatabase Design (continued) 


Open Lab 4:30-5:30 Project Consultations 


   


 
 
 


Open Lab Time Day 1 = 1 hour 
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 AGENDA 
 


Day 2 – Data Management and Development  


Discussion 8:00-8:30 Review  


Exercise 3 8:30-9:30 Creating, Exporting and Importing Metadata  


 
9:30-9:45 Break 


Exercise 4 9:45-12:00 Working with Tables 


 
12:00-1:00 Lunch 


Open Lab 1:00-2:30 Project Consultations 


 
2:30-2:45 Break 


Exercise 5 2:45-4:30 Working with LIDAR and Terrain Datasets 


Open Lab 4:30-5:30 Project Consultations 


 
5:30-7:00 Dinner 


Open Lab 7:00-9:00 Project Consultations 


   


 
 
 


Open Lab Time Day 2 = 4.3 hours 
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 AGENDA 
 
 


Day 3 – Data Management and Development  


Discussion 8:00-8:30 Review  


Exercise 6 8:30-9:30 Editing and Topology  


 
9:30-9:45 Break 


Exercise 6 9:45-11:30 Editing and Topology (continued) 


 
11:30-12:30 Lunch 


Exercise 7 12:30–2:30 Model Builder 


Open Lab 2:30-5:30 Project Consultations (open break) 


 
5:30-7:00 Dinner 


Open Lab 7:00-9:00 Project Consultations  


   


   


 
 


Open Lab Time Day 3 = 5 hours 
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AGENDA 
 
 


Day 4 – Data Analysis  


Discussion 8:00-9:00 Review  


Exercise 8 9:00-10:00 Suitability Analysis  


Open Lab 10:00-12:00 Project Consultations (open break) 


 
12:00-1:00 Lunch 


Open Lab 1:00-5:30 Project Consultations (open break) 


 
5:30-7:00 Dinner 


Open Lab 7:00-9:00 Project Consultations/ Work on Presentations 


 
 
 


Open Lab Time Day 4 = 8.30 hours; Sum = 19 hours 
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AGENDA 
 
 


Day 5 – Project Presentations 


Open Lab 8:00-10:00 Work on Presentation (open break) 


Presentations 10:00-12:30 Presentations  


Wrap-Up 12:30-12:45 Wrap-Up and Graduation 
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Appendix 2 - Customizing ArcMap 
  
 
 


Session Objectives:  At the conclusion of this session, you will be able to: 
 


 
 
 Add, delete and move commands 
 
 Create new toolbars and commands 


 
 Change and set command properties 


 
 Register and install a custom DLL 


 
 Install a custom Add-In 
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Developed by:  Sean Fields (Jan 2005) 


Revised: Karen Klinger (Dec 2008), Eric Kelchlin (Nov 2009), Sean Fields (Nov 2011) 
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Customizing ArcMap Overview 
 
Users can customize the ArcMap interface to suit their individual needs and increase 
productivity.  Knowledge of programming languages is not needed to customize 
ArcMap. 
 
Toolbars and menus in the ArcMap user interface contain commands.  Commands are 
buttons, tools, menus, macros and UIControls.  Each command has associated code.  
 
The customize dialog box puts the interface in design mode.  With the Customize 
dialog open, you can rearrange and remove existing commands, add new toolbars and 
commands, and change command properties.  The commands do not execute when 
you are in design mode. 
 
While in design mode, Right-click on a control to view and change its properties.  
Characteristics that define the appearance of the control are name, image, display text 
or image, and begin a tool group.   
 
Users can store their customizations on three levels.  The customizations are saved to 
the specified level once the Customize dialog is closed. 
 


1. Normal Template - affects all documents 
2. Base Template - affects all documents using the template  
3. This Document - affects the current document only  


DLLs (Dynamic Link Libraries) are custom commands that have been coded and 
compiled in other programs and are ready to import into ArcMap.  DLLs may need to be 
registered through the operating system prior to adding to the ArcMap interface. 


ArcGIS 10 introduces several new and innovative features that make it easier for users 


to customize and extend the ArcGIS Desktop applications, including the new Desktop 


add-in model. Add-ins are easily shared between users as they do not require 


installation programs or administrative privileges to install.  Add-ins are added to a 


system by simply copying them to a well-known folder and removed by deleting them 


from this folder. Add-ins can easily be shared between users within an organization by 


distributing the Add-in file (e.g. selectionsample.esriaddin) 
 
All data are located in the D:\CSP7200\Appendix\Custom folder
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SECTION 1 – Exploring the Customize dialog 
 
In this section you become familiar with the Customize dialog box 
 
1. Open ArcMap.  Click on the Customize menu and Select Customize Mode... The 


Customize Dialog opens. 
 


 
 
2. Click on the Toolbars Tab  on the Customize Dialog.  You can add and remove 


toolbars from the interface through the checkboxes next to the toolbar name. 
 


                         







GIS Project Design for Natural Resources                                                                                   2011 
U.S. Fish and Wildlife Service                              National Conservation Training Center 


 


Customizing ArcMap                                                                                      5 
 


3. Click on the Commands Tab. Take a few minutes and review some of the 
commands that are available to the user through the different categories on the 
right.  Note that many of the commands are not available on the stock user 
interface toolbars. 


 
4. To add a new tool to your default ArcMap desktop toolbar, simple select a 


Command item and drag onto the desktop toolbars.  Your new command is 
dropped wherever you release it on the toolbar. 


 


  
 


5. Finally, click the options tab on the Customize dialog. Become familiar with the 
options in this part of the Customize dialog.   


 


 







GIS Project Design for Natural Resources                                                                                   2011 
U.S. Fish and Wildlife Service                              National Conservation Training Center 


 


Customizing ArcMap                                                                                      6 
 


6. When might a user want to use the Large Icons option or lock the customizations? 


_________________________________________________________________


_________________________________________________________________ 


 
7. Click Close when finished. 
 
 
SECTION 2 – Change the properties of a control   
 
In this section you will change the properties of a command that you have added to the 
interface 
  


1. Open the Customize dialog. 
 


2. Add a command of your choice to any toolbar on the interface.  
 


3. Right click the new tool in the toolbar and change the name and image of the 
control. 


 


 
 


4. Display the tool with text only. 
 


5. Display the tool with image only. 
 


6. Display the tool with image and text.   
 


7. Begin a new group.  Why would a user want to create groups of tools?    
 


8.  Click Close on the Customize dialog when finished. 
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SECTION 3 – Create a new toolbar and add a DLL from the internet  
 
We will be downloading and adding a custom tool to the user interface.  The 
downloaded DLL will have to be registered with the system before it can be used. 
NOTE: administrative privileges are required to register a DLL on a computer 
 


1. Open Internet Explorer. 
 
2. Navigate to http://arcscripts.esri.com/details.asp?dbid=13058.  Click download 


and agree to the license agreement. Save the DLL to the 
TEC7114\Appendix\Custom directory. 


 
3. Close Internet Explorer. 


 
4. Register the DLL on your system using Regsvr32.  On the taskbar Click Start > 


Run.  In the Open field, type regsvr32  “D:\TEC7129\Appendix\Custom 
AS13058.dll”.  If the file registers successfully, the following message appears 
on the screen: 


 


                           
 
 


NOTE:  While not all DLLs need to be registered on the system, it is good 
practice to register all new DLLs to assure proper command execution. 
 


5. Open the Customize dialog.   
 


6. Click the Toolbars tab and select New on the right side of the dialog. 
 


7. Give the toolbar a name and save it in the current document.  
 


8. Click the Commands tab and add three or four tools from the various command 
categories.  Click the Add from File button and add the DLL you saved to the 
\TEC7114\Appendix\Custom directory.  Once you add a custom tool from file, 
it will be placed in the appropriate category in the Customize dialog box. A new 
category is created for this tool.   


                              
9. Close the Customize dialog. 


 
10. Use the tool.  What is it designed to do? 
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SECTION 4 – Install an ArcMap Add-in  
 
Add-ins are ArcMap customizations that are easily shared between users as they do not 
require installation programs or administrative privileges to install.  You will be adding 
an Add-In to ArcMap that provides the user with custom selection tools.  The Selection 
Sample VB.NET Add-In is a developers sample provided with the ArcGIS 10.0 Software 
Developers Kit. 
 


1. Open Windows Explorer and navigate to D:\TEC7129\Appendix\Custom 
directory.  Double-click on the selectionsample.esriaddin file to open the 
ArcGIS Add-In Installation Utility.  Click Install Add-In to install the Selection 
Sample Add-In. 


 


                                    
 
 
 
 
 
NOTE:  Once Add-ins are installed on a computer, ArcGIS stores them on the local 
computer in the My_Documents\ArcGIS\AddIns\Desktop10.0 directory.  Each Add-In 
is stored in a folder with a unique ID (e.g. {BB1BB09E-F0A3-42c3-A62D-
3062464AE48A}).  Users can distribute the add-in file to share with other users. 
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2. Open ArcMap.  Click on the Customize menu and Select Customize Mode... 
The Customize Dialog opens. Check the box next to the Selection AddIn 
Toolbar on the toolbars tab to add the toolbar to the ArcMap interface.  Close the 
Customize Dialog. 


   


                               
 


3. Click on the Customize menu and Select Extensions… Check the box next to 
the Selection Sample Extension to turn on the extension. 
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4. Add data to ArcMap and select features using the Selection Add-In Toolbar.  
Several custom components are included on the toolbar, including a dockable 
window, several buttons, and menus containing commands. 


 


    
 
5. After you have familiarized yourself with the Selection Add-In Toolbar, remove 


the Add-In from the computer by selecting Add-In Manager under the 
Customize menu on the Standard Toolbar. Select the Selection Sample 
VB.NET Add-in under the My Add-Ins panel on the left of the Add-In Manager.  
Click the Delete this Add-In button to delete the Add-In from the computer. 


 
           


 





